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Chapter 1:Accounts

Chapter 1: Accounts  

Section 1.1:How to create an account?

This article explains how to create any type of account (checking, banking, credit card, 

cash, savings, Online Banking, loan, investment and crypto/forex).

Invoking the account creation window

There are few ways to start creating a new account:

1. if you have no accounts in your MoneyWiz database, you'll be greeted with a 

welcome message, inviting you to "start by creating an account". Clicking on the 

"New Account" button visible below will allow you to choose the account type. 

2. at any time, you can select "File" from the menu bar and navigate to New -> New 

Account. 
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Section 1.1:How to create an account?

3. at any time, you can click on the + button near the bottom-left of the user interface 

and select New Account, 

4. at any time, you can use a keyboard shortcut: Shift + Command + A on Mac and 

Shift + Control + A on Windows. 

You'll then be asked to choose between two account modes:

• Automatic sync with bank/financial institution – choose this if you wish 

to create an Online Banking account, 

• Manual transaction entry or import – choose this if you want to manage 

your accounts manually or import transactions in form of CSV, QIF, OFX, QFX or 

MT940 files. 

Remember that at any time you can disconnect an Online Banking account to make it 

manual and connect a manual account to Online Banking.

Choosing an account type
If you have chosen the Online Banking account mode in previous step, you don't need to 

choose an account type – it'll be selected automatically depending on the accounts you 

select to connect.
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Section 1.1:How to create an account?

If you have chosen the manual account mode, you'll now be asked to select the account 

type:

• Checking account (Banking) – use this for your daily checking/banking 

accounts or when in doubt, 

• Credit account – use this for credit card accounts, 

• Savings account – use this for regular saving accounts (non-investment), 

• Loan account – use this for your mortgages, car loans and other accounts with 

an APR and monthly repayments, 

• Cash/Wallet accounts – use this for money you carry in your wallet or purse, 

• Investment account – use this for tracking your holdings and assets, 

• Forex/Crypto account – use this for tracking your forex and crypto currency 

holdings and trades. 
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Section 1.1:How to create an account?

Some accounts have more detailed overview – see other guide sections to learn more.

Section 1.2:How to edit an account?

Editing an account allows you to make changes to the account name, opening balance, 

connect the account to Online Banking, disconnect it from Online Banking, change the 

icon and more. Please note that it is not possible to change the account type (e.g. it is not

possible to convert a Savings account to Cash/Wallet account).

Different ways of editing the account

• the easiest way is to double-click on the account name on the accounts list in the 

sidebar, 

• it's also possible to right-click on the account name on the accounts list in the 

sidebar (if you're on a Mac and nothing happens on right-click, it means it is 

disabled. You can try left-click while holding control key instead). 

When the account properties window opens, you can modify many of the account original 

properties.
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Section 1.3:What account properties can I modify?

Section 1.3:What account properties can I modify?

When creating or editing an account, you can set and change various account properties 

and settings. This guide will explain what are they and where to find them.

The account properties window has two tabs that you can switch in three ways:

1. click on the tabs on top, 

2. swipe your finger to left and right on the track pad, 

3. click on the rounded buttons at the bottom. 

• Basic tab 

• Account name – your name for the account, allowing you to easily 

distinguish it from other accounts, 

Page 10 out of 172



Section 1.3:What account properties can I modify?

• Opening balance – the starting balance of the account (before first 

transaction happened). Your closing balance depends on the opening 

balance of the account and transaction stored in it. 

• Account currency (displayed next to Opening balance) – click to pick 

from enabled currencies. Don't see yours? Make sure to enable your 

currencies in MoneyWiz Settings -> Currencies before trying to change them 

here. 

• Auto-clear transactions – if checked (it is checked by default), new 

transactions that you create in this account will be cleared automatically. 

Change this setting if you wish for new transactions to be created (arrive) as 

pending transactions. 

• Connect to Online Banking or Disconnect from Online Banking 

– this button allows you to connect or disconnect an account from Online 

Banking respectively (it is only visible when editing an existing account). 
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Section 1.3:What account properties can I modify?

• Extended tab 

• Additional information – any text-based information you might to add, 

such as the daily or weekly limits, contact information to your bank and so on.

• Checkbook Register – enable this if this account is used to write checks. 

More information. 

• Include in Net Worth – if enabled, this account balance will affect the 

total Net Worth calculation. If disabled, this account balance will be excluded 

from Net Worth calculation. 

• Put in Group – allows you to put your account in an account group, 

keeping your accounts list organized. More information. 

• Icon – select from a variety of icons to change the default one. 
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Section 1.3:What account properties can I modify?

Some accounts have slightly different properties – they are explained in more detail in their

respective guides.

Section 1.4:How to re-order accounts or account 
groups?

By default, the accounts list in the sidebar will list the accounts and account groups in the 

order they were created. However, you can change this if you wish.

To change the order of accounts or account groups, just click on what you want to re-

order, hold the mouse button down then drag it to a desired place and release the mouse 

button. There are a couple of things to note here:

• dragging an account under an account group will put that account into the group, 

• account groups cannot be nested – this means that you cannot put an account 

group within an account group, 
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Section 1.4:How to re-order accounts or account groups?

• accounts that do not belong to any group will always be listed at the top, above 

account groups. This cannot be changed. 

Section 1.5:How to delete an account?

This guide contains instructions on how to delete an account and provides guidance to 

customers who wish to archive their old, unused accounts.

Deleting an account
To delete an account, please right-click on the account name in the accounts list in the 

sidebar. If you are on a Mac and nothing happens on right-click, it means that you have 

right-click disabled. In that case please left-click while holding control key.

You'll see a small menu appear. Please choose "Delete account". You'll be warned that 

the action is irreversible.
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Section 1.5:How to delete an account?

It is important to remember that deleting an account also deletes all account-related 

objects, such as transactions (including transfers, which are deleted from both accounts) 

and Scheduled transactions. If you wish to archive an account instead, please do not 

delete the account and read on.

Archiving an account
You should create an account group for your inactive accounts and put your account in 

that group. More information can be found later in this guide.

Section 1.6:How to archive an old, unused account?

If you create new bank account, you might want to reflect this in MoneyWiz. Given that the 

old account is not needed anymore, you might want to delete the old account.

In most cases you do not want to delete that old account!

Deleting an account would delete all account-related objects, like transactions stored in 

side. This includes transfer transactions that would be deleted from both accounts, 

affecting your other accounts' balances.

Instead of deleting old accounts, we recommend archiving an account. To archive an 

account, please create an account group for your inactive accounts (it might be just one 

group for all inactive accounts or a group per institution) and put your inactive accounts 

there. The account group name does not matter – you can pick any that you want.

Section 1.7:How to create an account group?

Account groups allow you to organize accounts – you can create groups based on the 

frequency of use ("Everyday accounts", "Savings – Do not touch!", "Archived accounts"), 
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Section 1.7:How to create an account group?

institutions ("Chase accounts", "Lloyds accounts") or any other criteria you might come up 

with.

To create an account group, you can:

• click on File menu bar then New -> New Group, 

• click on + button near the bottom-left and select New Group, 

• use a keyboard shortcut. Shift + Command + G on Mac and Shift + Control + G on 

Windows. 

You'll be asked to indicate the group name and the group currency. The group currency 

will be used to display the group total – the sum of all accounts stored within (only those 

selected to be included in Net Worth calculation). If you leave the currency to "Local 

currency", it'll be set to the currency you set in MoneyWiz Settings -> Currencies (and the 

account group currency will change accordingly whenever you change your local 

currency).

Once an account group is created, you'll probably want to add some accounts to it.

Page 16 out of 172



Section 1.8:How to put accounts in groups?

Section 1.8:How to put accounts in groups?

There are 2 ways of including an account into a group:

1. Click on an account name in the accounts list in the sidebar and drag it slightly 

below the group heading that you want to put the account in. 

2. Double click on an account name in the list of accounts in the sidebar, navigate to 

Extended tab (using buttons on top) and then use the "Include in groups" picker to 

choose the target group. 
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Section 1.8:How to put accounts in groups?

Remember that accounts do not have to belong to a group – it's optional. If you have 

account groups, accounts that are not part of any group will always be listed at the top of 

the list.

Section 1.9:How to collapse account groups so that 
they take less space?

Collapsing an account group makes it take much less space and hides the accounts that 

are stored inside.
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Section 1.9:How to collapse account groups so that they take less space?

It's easy to collapse or expand an account group – just click on the account group heading 

or icon (in the sidebar). That's it!
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Section 1.10:How to remove an account from a group?

Section 1.10: How to remove an account from a 
group?

Removing an account from a group will place it back into the top of the accounts list. There

are two ways to remove an account from a group:

1. Click on the account name in the accounts list in the sidebar, hold the mouse button

down and drag it out of the account group, place it in the desired location and 

release the mouse button. You can use this to remove an account from a group or 

move it to different one. 

2. Click twice on the account name in the list of accounts in the sidebar, switch to 

Extended tab (using buttons on top) and then use the "Include in group" picker to 

either move or remove the account from a group. 
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Section 1.10:How to remove an account from a group?

Section 1.11: How does Online Banking work?

Online Banking feature can download your banking transactions and investment trades 

automatically from the supported banks and institutions. We support not only regular 

banks like Chase or Lloyds but also investment platforms like E*Trade, crypto trading 

platforms like Bittrex and miscellaneous platforms such as PayPal. Overall we support 

thousands of banks worldwide. To see the complete list, please check out this guide.

Using Online Banking requires to have an ongoing and active MoneyWiz Premium 

subscription (monthly or yearly).

To begin using Online Banking, simply start creating new account and select Online 

Banking account type. Alternatively, if you have accounts created already with existing 

transactions, you can connect an existing account to Online Banking instead.
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Section 1.11:How does Online Banking work?

You'll be shown a list of banks with a search bar. Once a bank is selected, you'll be asked 

to authenticate (provide banking credentials) for your bank. If all goes well, you will see the

list of accounts that you can import. Select those that you wish to sync in MoneyWiz and 

proceed. Upon first connection MoneyWiz will download your historical transactions for a 

given account.

As you refresh your accounts, MoneyWiz will download newer transactions you've made 

recently (read all about automatic, background and manual syncing here). MoneyWiz will 

attempt to automatically categorize your transactions – but you can easily change the 

choices it makes and the algorithm will learn from your changes to improve over team. 

Please continue reading to learn more about Online Banking and available configuration.
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Section 1.12:How to connect, disconnect or reconnect an account from Online Banking
service?

Section 1.12: How to connect, disconnect or 
reconnect an account from Online Banking service?

If you have created an account as a local (manually managed) account, you can easily 

connect that account to Online Banking service now. Similarly, if your account is already 

connected to Online Banking but you wish to disconnect (or reconnect) it from that service 

(while preserving or deleting transactions downloaded already), you can do so with just a 

few clicks.

Connecting an existing account to Online Banking service
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Section 1.12:How to connect, disconnect or reconnect an account from Online Banking
service?

To connect an account to Online Banking, you need to access the account properties 

window. You can do this in two ways:

1. Double click on the account name in the list of accounts in the sidebar. 

2. Right-click on the account name in the list of accounts in the sidebar. If you're on a 

Mac and nothing happens on right-click, it means you have this function disabled. 

Try left-clicking while holding control key on your keyboard. From the menu that 

appears, select Edit. 

When the account properties window opens, you should see a "Connect to Online 

Banking" button. Please click it – you'll be shown a list of banks and institutions we 

support. You should then search for yours and in the next window, select the account you 

wish to edit.

Please note that even though we might support more than one account for your institution, 

when following this process you'll be able to select just one account for import. That's 

because you're connecting an existing account to Online Banking – and you can obviously 

connect just one Online Banking account to one MoneyWiz account. If you wanted to add 

more Online Banking accounts, you'll need to either repeat this process for each existing 

account or create the Online Banking accounts from scratch.

How will connecting an existing account to Online Banking 
affect my existing transactions?
When connecting an existing account to Online Banking, your existing transactions will not

be affected in any way (they will not be deleted or modified).

MoneyWiz will look for the most recent transaction in your account (if there are any 

transactions) and download transactions from that transaction onward. This means if your 

most recent transaction is from today, most likely no transactions will be downloaded upon

connection (but newer transactions made tomorrow and in the future will download).
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Section 1.12:How to connect, disconnect or reconnect an account from Online Banking
service?

Disconnecting an existing account from Online Banking 
service

To disconnect an account from Online Banking, you need to access the account properties

window. You can do this in two ways:

1. Double click on the account name in the list of accounts in the sidebar. 

2. Right-click on the account name in the list of accounts in the sidebar. If you're on a 

Mac and nothing happens on right-click, it means you have this function disabled. 

Try left-clicking while holding control key on your keyboard. From the menu that 

appears, select Edit. 

When the account properties window opens, you should see a "Disconnect from Online 

Banking" button. When you click it, you'll be asked whether to keep or delete transactions 
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Section 1.12:How to connect, disconnect or reconnect an account from Online Banking
service?

downloaded from Online Banking so far. If you click keep, your account will be 

disconnected from Online Banking but there would be no changes made to transactions. If 

you click delete, your account will be disconnected from Online Banking and any 

transactions that were downloaded automatically would be deleted.

Reconnecting an existing account with Online Banking 
service
Reconnecting an account from Online Banking might help in some cases, for example 

when your banking password got changed and you need to supply a new one. To 

reconnect an account with Online Banking, please first follow the instructions above for 

disconnecting, then connecting the account.

Please note that in some cases it makes a difference whether you reconnect accounts one

by one or whether you first disconnect all accounts from a particular bank and then 

connect them again one by one. If you're not sure which approach is better or were linked 

here by our support team and we did not mention a specific approach, it's always better to 

reconnect accounts one by one (fully disconnect one account, fully connect that account 

back and only then move to another account).
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Section 1.13:How to create transactions in an Online Banking account?

Section 1.13: How to create transactions in an 
Online Banking account?

Accounts connected to Online Banking will regularly sync transactions automatically from 

your bank or institution. However, there might be a time when you wish to create 

transactions manually. Because the + button you'd normally use is not available in Online 

Banking accounts (it is replaced with refresh button), you need to do this differently. You 

can do this in two ways:

1. Use keyboard shortcuts to invoke transaction entry window. It's Command + E on

Mac/Control + E on Windows for expense, Command + I on Mac/Control + I 

on Windows for income and Command + T on Mac/Control + T on Windows for

transfer. 

2. Right-click on the account name in the list of accounts in the sidebar. If you're on a 

Mac and nothing happens on right-click, it means you have this function disabled. 

Try left-clicking while holding control key on your keyboard. From the menu that 

appears, select New Transaction. 
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Section 1.13:How to create transactions in an Online Banking account?

What happens if I manually create a transaction and it arrives 
via Online Banking later?
When downloading transactions from Online Banking, MoneyWiz looks for possible 

duplicates. It does that by searching for transactions that meet both of the following 

conditions:

1. transaction amount is *exactly* the same, 

2. transaction date is within 3 days range (either way, to account for weekends). 

If MoneyWiz finds a match, it will not download the transaction from Online Banking but 

instead update the existing transaction with missing information (it there is any). If 

MoneyWiz does not find a match, it'll download the transaction coming from your bank.

Section 1.14: How to configure Online Banking 
automatic transaction categorization?

MoneyWiz is designed to categorize transactions coming from online banking 

automatically, but it may require some help from you.

There are several sources where MoneyWiz is trying to get information about what the 

proper category of a transaction should be, and in this topic we will discuss the most 

popular ones.

Category from online banking service provider (Salt Edge or 
Yodlee)
Both providers have their own private algorithms for trying to detect the category of every 

transactions. With some banks, especially in the United States, they do better; with some 

banks it’s not so great. With this source MoneyWiz does not expect you to do anything – it 

just takes the category from the service provider and converts it to a MoneyWiz category. 

If you don’t already have this category, MoneyWiz will automatically create one for you.
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Section 1.14:How to configure Online Banking automatic transaction categorization?

This may be annoying if MoneyWiz is constantly creating for you categories that are 

needed. If you want you can disable automatic creation of new categories by editing your 

account and changing the Extended settings.

Category from payee
You may already be aware that MoneyWiz is able to learn how you categorize transactions

based on your descriptions and payees. This is valid for manually created transactions as 

well. So if you go to Starbucks, when creating a transaction if you select the Starbucks 

payee, MoneyWiz automatically pre-fills your category with the category you usually use 

with this payee. The same is valid for transactions downloaded from online banking.

So make sure that:

• your list of payees is clean and tidy, meaning there are no duplicates with different 

spelling and no unused payees, especially if they have weird numbers. 

• when a transaction is downloaded with a correct payee and wrong category, do edit 

the transaction selecting the proper category and do not delete the payee, as 

MoneyWiz will use it the next time you shop at this place. 

Category from description
In many cases, payee information is not available for online banking transactions. In this 

case MoneyWiz scans the transaction description and tries to find a match with your list of 

payees. If it finds a match it will use this payee to find a category. It is important that you 

help this algorithm by setting up proper payees in MoneyWiz. Here is a list of tips, that may

be helpful:

• the comparison is not case sensitive. If the descriptions of your transactions are all 

capital letters, you don’t have to create your payees with just capital letters. 

• it can be a partial match, meaning that your payee doesn’t have to be the entire 

description of the online banking transaction. 
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Section 1.14:How to configure Online Banking automatic transaction categorization?

• it’s a strict comparison, meaning that the description of the transaction has to 

contain the payee name in its entirety. 

Examples

Transaction
Description

Payee in
MoneyWiz

Match

STARBUCKS Starbucks Yes
xxxxxx *9283 
STARBUCKS *2382 xxxx Starbucks Yes

xxx*9283STARBUCKS*23
82 Starbucks Yes

xxx*9283O2*2382 O2
No, because the payee needs to be at 
least 3 letters

xxx*9283 O2 *2382 O2
Yes – the payee is still just 2 letters but 
the spaces help MoneyWiz locate it

McDonalds McDonald’s No
HotelHilton Hotel Hilton No
Appl* Apple No

Amazon Prime
Amazon, Prime (2 
separate payees) Amazon, because it’s a longer match

Cafe Golden Books Cafe Books No
Cafe Golden Books Golden Book Yes
Note, that is it not sufficient to just have the payee in your list of payees. That will help 

MoneyWiz match the payee, indeed. But if you need MoneyWiz to recognize the category, 

you will have to have an existing transaction with proper payee and category, so 

MoneyWiz can read from it. For this reason, it’s common to have to set the proper payee 

and category at least 2 times before algorithm kicks in.

Section 1.15: How to track loans?

Because we aim to make MoneyWiz the complete finance-management suite, we've also 

introduced the feature to track loans inside the application. You can track your mortgage, 
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Section 1.15:How to track loans?

car loan and any other loan with APR automatically applied, as well as smaller, more 

personal loans.

Creating a loan with APR
To begin, start creating an account, select manual type and proceed with Loan account 

from the picker. Please note that loan accounts are not supported for Online Banking 

feature at this time.

You'll be asked to provide some information about your loan:

• Name: this is the name of the Loan account. You can type in whatever feels 

descriptive enough. For example "Auto Loan". 
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Section 1.15:How to track loans?

• Principal amount: that is the amount of loan which you signed a contract for 

with your banking or other financial institution; it doesn’t include any interests or 

down payments. 

• APR %: APR stands for "Annual percentage rate", it usually includes both the 

interest and all additional bank fees around your loan (if you wish to create an 

interest-free loan please see this guide). 

• Duration: most loans are paid off on a monthly basis, so set the duration with 

number of months. 

• Start date: this is the date when you signed the contract. 

• First due date: this is the date when you are required to make your first payment

towards this loan; note that it’s important to set those correctly as even if you start 

date and first due date are different, you will be accountable for interests during the 

time between these two dates and that later affects your entire payment schedule. 

Notice that at the top, there are Basic and Extended tabs. In the Extended tab, all options 

are the same as for the other types of accounts, but there is one additional option called 

"Payment Plan". Without filling out the properties of your payment plan you 

will not be able to complete the Loan account creation.

Payment plan
Here you will be required to fill out:
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• Account used for payments: this is necessary so that MoneyWiz can 

automatically create for you a scheduled transfer and register your past payments 

towards this loan. 

• Category for principal: based on the transaction amounts towards the principal

category, the app will calculate the balance of your loan account; this is needed 

because you make payments consisted of principal and interest, but only the 

principal part is affecting your remaining balance. 

• Category for interest: this is needed so that app can make reports regarding 

your interest payments – this can help you make important decisions about your 

finances. Please note that it cannot be the same as the category for Principal. 

• Payee: this is an optional field; you may want to select as payee your banking 

institution. 
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• Plan type: there are 2 options here – Equal payments and Custom plan, these will

be explained later in this guide. 

• Payment schedule: with the information that you’ve entered so far MoneyWiz 

can make a good prediction of what your payments should look like. The payments 

are calculated as an amortizing loan – more on this particular type of loan will be 

explained later in this guide. 

The monthly payments are calculated as an Amortizing loan. You can refer to Wikipedia to

find out what exactly that means if you are not already familiar with the term. Please, note 

this algorithm takes your principal amount, annual rate and number of monthly payments 

and additionally we include the extra interest that you pay for the period between the start 

date and the first due date.

Please, contact us in case you have a loan that is not an amortizing loan – we are open to 

providing more algorithms for calculating the loan payments.

Monthly payments
Notice the Payment schedule button. Click on it to see the entire payment schedule for

your loan. You can click on each monthly payment and it will be opened in a new page and

allow you to change it. If you selected "Equal payments" for plan type, you will not be able 

to change the Payment amount of any monthly payment. If you selected "Custom plan" 

you are allowed to change everything about all of your payments.
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In both cases in order to save the entire payment schedule, please make sure the total 

principal amount on the bottom of the list is equal to the principal amount that you initially 

entered.

To create the account, just save your changes in the Payment plan and use the Create 

buttons. MoneyWiz will ask you whether to register past payments for the loan account – 

but only if your first payment date is in the past. If you agree, MoneyWiz will create past 

transactions for you:
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Please note that the balance of the Loan account is affected only by the amounts in the 

principal category, while the balance of the account used for payments is affected by the 

full amount of the payments.

I can't create loan account – the payment plan button is 
flashing!
As we've noted earlier, your interest and principal categories need to be different. 

Otherwise reports would not be meaningful.

The loan formula
You can find sample spreadsheets (in Excel .xlsx and Open Document Spreadsheet .ods 

formats) for the formula MoneyWiz uses in calculating your loan in our knowledge base.

The thing that those spreadsheets don't account for, but MoneyWiz does, is that the lender

may give you a longer period between signing of the loan and the first due date. If that 
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number is more than 30 days, the app will adjust the entire payment schedule to account 

for the increased interest in the beginning. If the difference between start date and first due

date is exactly 30 days, then the calculations would be exactly as on the spreadsheet.

Transactions toward loan accounts
The transactions towards Loan accounts are a special type of transactions – these are 

transfers which allow you to enter category and payee and be split by categories to handle

separately principal and interest.

You can manually create transactions towards Loan accounts and enter principal only or 

interest only payments. Additionally you can create more scheduled transactions towards 

your loan account (in case you and your spouse are paying off a loan together, but from 

separate accounts).

Paying off a loan
Once you are done paying off your loan the balance of the Loan account in MoneyWiz will 

reach 0. Please, note that deleting the Loan account at this point is not a good option since

it contains transfer transactions and deleting those will affect the balances of your other 

accounts. A better option is moving the account to a group where you keep your retired 

accounts (old and no longer used accounts). This way the paid off loan will not get in the 

way of your daily operations, but you will get to keep the history of your transactions.

Section 1.16: How to track traditional investments?

This guide explains how to create an investment account, where you can track 

investments or retirement accounts such as brokerage accounts, commodities trading, 

401k, IRA and others – basically any account that trades (Buy or Sell) any type of 

securities. You can track your investments manually (entering the buys and sells yourself) 

or connect it to the powerful Online Banking feature to sync that information automatically.
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Disclaimer
MoneyWiz is not meant to be a trading platform – it doesn’t allow you to trade, it doesn’t 

give you advice what to trade. It’s a monitoring tool, meaning it just monitors your balances

and helps you understand how they change and how they affect your overall Net Worth.

MoneyWiz support team is happy to help you with any questions you might have regarding

this feature but we are not allowed to give advice on what or when to trade and will not 

provide guidance on that. Any investment decisions you make are entirely yours – so are 

both the gains and losses that your decisions result in. We take no responsibility for those.

Two ways of tracking your portfolio
There are two ways to track an investment account in MoneyWiz:

Automatic tracking (via Online Banking)
We support over 3500 trading institutions. If your institution is supported, you can connect 

to it to automatically retrieve current balance, current holdings and past transactions. The 

full list of supported institutions is only available in the application itself – download the free

version of MoneyWiz and search the list for yours!

Manual tracking
In case your institution is not supported or you prefer not to connect to it via our Online 

Banking feature, you can manage your investments manually. You’ll be able to add buy, 

sell and other types of operations manually and still track the current worth of your capital.

For manual trading tracking we support accounts in any currency and any stock exchange 

and trading symbol that you can find on the Yahoo! Finance service – not just the New 

York Stock Exchange. This means that if you can find information on your stock exchange 

and stock symbols in Yahoo! Finance service, you will be able to manage it manually in 

MoneyWiz. Once you download MoneyWiz, be sure to search the list of Online Banking 
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accounts for your trading platform though – perhaps it is supported for automatic tracking 

too!

What if neither my institution, nor my symbol is available?
If you cannot find your investment institution on the Online Banking services list and 

Yahoo! Finance does not have a record for the stock exchange and symbols you’re 

interested in you can still add the investment account to MoneyWiz, filling out all of the 

details about the stock manually. However, because MoneyWiz cannot download the 

current share prices from Yahoo! Finance, it will not be able to automatically update the 

value of your stock and generate the historical graph for you.

You can also place a request for your institution to be added to the Online Banking 

platform from here. Please note that while Salt Edge is our partner, they are a separate 

company so we have no knowledge or control over which banks are being added next so 

we cannot estimate when the integration with your institution might be completed.

Creating an investment account
You can add multiple investment accounts to your MoneyWiz database – you are not 

limited to just one. This allows you to track your brokerage account separately from your 

retirement account for example.

Using Online Banking
To add an Investment account for automatic tracking, start adding new account in 

MoneyWiz then choose Online Banking account type. Search the list for your trading 

institution to see if it’s available:
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After you authenticate MoneyWiz will start downloading your current holdings. Once it 

finishes, you’ll be able to see all that data in MoneyWiz and have it contribute to your total 

Net Worth in the application.

For manual tracking
To add an account for manual tracking start adding new manual account, scroll to the 

bottom and find "Investment" type. Tap on it and start filling out the details.
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• Account name: a name for this account that will help you identify it on the list. 

For example "E*Trade" or "401k". 

• Cash Balance as of date: in the next field you need to enter your cash 

balance. Here you allocate the date to which your cash balance will be tied. 

• Cash Balance: enter your cash balance as of the date selected above (if you 

leave the date as today then enter your cash balance as of today). Tapping on the 

currency code would also allow you to choose a currency (we support investments 

in various currencies; if you don’t see your currency make sure it’s enabled in 

Settings -> Currencies). 

If you switch to Extended section, you can edit other details of the account – just like 

described in account properties guide.
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After you confirm those details, you’ll be asked to add your positions to the account. For 

the purpose of this tutorial, we’ll populate a fictional portfolio. From the buttons at the 

bottom choose Add – a new screen will appear.

You’ll be asked to enter some information about your security. Note that only the first three

on top and Buy date are required – the rest is optional.

• Symbol: the symbol of your security. As you begin to type, MoneyWiz 

automatically searches the Yahoo! Finance database for the entered query and tries

to pull the data for you. In order for MoneyWiz to be able to automatically refresh 

the stock price your symbol must be present in the Yahoo! Finance database. 

• Holding type: the type of the security. 

• Buy date: enter the date of this buy operation (defaults to today). 
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• Number of shares: the number of securities you’ve purchased. Note that it can 

be a negative number in case of borrowed shares or a fractional number if the 

Holding type is "Mutual Fund". 

• Price per share: will be downloaded from Yahoo! Finance database if your 

symbol is recognized. You might to adjust it however as MoneyWiz presents you 

the current stock price: you are likely to have purchased it at a different price. 

• Total price: is calculated dynamically (Number of shares x Price per share). 

• Commission: here you can enter the commission you’ve paid when performing 

this buy operation. 

• Description: description of this operation. By default it pulls the name of the stock

from the symbol. 

After you add the details you want, your security is ready to be added to your portfolio. In 

our fictional portfolio, we’ve added several more stocks. Before you confirm account 

creation you can preview the securities you’ve added and their total value.
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Once your investment account is created you can modify, change its position on the 

accounts list and delete just like any other account – see the other account guides for 

more information.

Working with Investment accounts
Now that our account is created we can see a beautiful chart of our portfolio:
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Finding your way around the account
The Investment account has a different layout from most other accounts. It features 3 

major areas:

1. Investment chart: showing you how your top holdings are performing. 

2. Holdings view: displaying all of your holdings in one clear list, displaying basic 

information about them and their performance. 

3. Trades view: listing all trades and transactions for this account. 

In MoneyWiz for Desktop, you always see the Investment chart but you can switch 

between Portfolio (Holdings) view and Trades (Transactions) view using the 

buttons below the chart.

You can also see some detailed information about your holdings just above the 

Investment chart:

Page 45 out of 172



Section 1.16:How to track traditional investments?

• Cash: how much cash you have in your portfolio. 

• Market Value: the combined market value of all your securities. 

• Total Value: Cash + Market Value. 

• Change: represents the difference between price when the position was opened 

and the current price. 

Creating new transactions and trades
Creating a new trade or transaction is as simple as adding a regular transaction. That's 

why you begin by simply clicking the + button in the bottom-right of the account. You can 

choose from:

• Buy–allows you to buy more stock. Note that Buy to open and Buy to close are all 

the same in MoneyWiz. 

• Sell–allows you to sell some stock. Note that Sell to open and Sell to close are all 

the same in MoneyWiz. 

• regular transaction types (expense, income, transfer, adjust balance) that are

covered in Transaction basics tutorial. 

To illustrate how you can add an operation to your portfolio, let’s purchase more stock to 

our fictional portfolio. To begin we click on the + button at the bottom and choose Buy. 

You’ll be presented with the view very much like the one we saw when adding stocks to 

our investment account when we were creating it. Once again you need to enter the 

symbol, number of shares and price per share. Other fields are optional. Adding a Sell 

operation works exactly the same way.

A couple of notes:

• it is possible to have a negative holding value (e.g. -7 MSFT), 
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• if at any time your holding reaches 0 value, it'll disappear from your Portfolio but the 

transactions will remain in Trades view. In order for the holding to reappear in 

Portfolio, its value needs to become different than zero, 

• you can hover your mouse or finger over the Investments chart to display holding 

values for a particular date, 

• you can use the buttons above the investment chart to quickly change the period 

the chart will cover or use the fields to the right to set the period more precisely to 

your liking, 

• you can refresh the exchange rates (coming from Yahoo! Finance) by clicking on 

the refresh rates button: in MoneyWiz for Desktop, it's below the chart (next to Last 

refreshed information) and in MoneyWiz for Mobile it's in the top-right corner of the 

screen. 

Section 1.17: How to track assets?

While MoneyWiz does not have a direct support for assets, you can use our investment 

account to track them. Please read the investment accounts guide for details on how to 

use the tool overall – this guide will provide you with guidance on how to tweak it to track 

custom assets (like your house, car, etc).

You'll have to create a manually managed investment account. The cash balance should 

be 0.00 – if it's anything else, it'd mean that there's any non-asset money laying around 

somewhere. You might wonder how you'll register all of the assets value with 0.00 cash 

value – don't worry! When creating your investment account for the first time, you're 

presented with an opportunity to describe your portfolio – entering holdings "for free". 

Please think carefully what assets you wish to track and how much are they worth as you 

won't get this chance anymore. Should you wish to log another asset at later date to this 
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account, you'll need to use the Buy transaction, which will reduce the cash amount value 

(but we'll get to that later).

When trying to find share prices for you, MoneyWiz looks up Yahoo! Finance database. So

in order to prevent Yahoo! Finance from interfering with your custom asset prices, just 

enter a holding that is not present in their database:

• PAWELSHOME for your home, 

• PAWELSCAR for your car, 

• and so on. 

This will allow you to set a custom price for each asset. If you wish to register an asset 

such as a house, you want to enter price per share to the overall value of your house and 

set the quantity to 1. If you own multiple assets of the same type, you can enter a different 

quantity but only if the assets are all of the same value and depreciate at the same rate – 

otherwise you should use different symbols (PAWELSBMW, PAWELSMINI).

Once you describe your portfolio, go ahead and finish creating your account.
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Updating the asset value
Once it's time to re-evaluate your assets value, just head over to Holdings tab, click on an 

asset and use the Update price button.

As you use the Update price button, you'll see that the chart above gets more and more 

detailed, instead of remaining flat.
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Purchasing a new asset
If you bought a new asset or simply want to register another one, you'll have to use the 

Buy feature to buy a new holding. This will reduce your cash value by the value of the 

asset. For accuracy, you'll want to bring the cash value back to 0. Probably the easiest 

way to do this is to right-click on the account name in the sidebar (or left-click holding 

control key if you have right-click disabled) and select Adjust balance. Set it to 0.00 and 

save.

Alternatively, you can of course transfer the missing money from your other account (the 

one that was actually used to purchase the asset). But since transfer transactions cannot 

have a category, you might want to keep that purchase logged as an expense in the 

original account and use the Adjust balance trick in your asset account.

Selling an existing asset
It's pretty much the opposite of the above. Use the Sell feature to sell your asset. It'll 

disappear from the portfolio but raise your cash value accordingly. Again, you can make a 

decision whether to transfer that value to your regular account or use the Adjust balance 

function and track the income separately with an income transaction.
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Section 2.1:How to create transactions?

Creating transactions in MoneyWiz is very important as those are the building blocks for 

your financial forecast overview. Online Banking feature allows you to import transactions 

automatically from your banks but even in those accounts you can create transactions 

manually.

First, let's talk about the transaction types that MoneyWiz supports:

1. expenses – reduce the balance of an account, 

2. incomes – increase the balance of an account, 

3. transfers – reduce the balance of the origin account, while increase the balance 

of another account, 

4. balance adjustments – when you want to simply adjust your account balance 

to a particular amount with a single transaction. 

5. refunds – reduce the amount of an expense by a given amount (e.g. when you are

partially or completely refunded for an item at the shop). 

6. reimbursements – reduce the amount spent in a particular expense category 

(e.g. when you are reimbursed in bulk for some type of fee at the end of the year). 

This guide focuses on the first 4 types of transactions.

You can start creating new transactions manually in 4 ways:

1. click on the + button in the bottom-right corner and select the transaction type, 

2. use one of the keyboard shortcuts: 

• ⌘ cmd + E on Mac or Control + E on Windows for expense, 

• ⌘ cmd + I on Mac or Control + I on Windows for income, 
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• ⌘ cmd + T on Mac or Control + T on Windows for transfer, 

3. right-click (or left-click while holding control key if you have right-click disabled) on 

the account name in the sidebar and select New Transaction. 

4. go to File menu bar at the top of the screen -> New -> and select the transaction 

type. 

If your account is connected to Online Banking, the first option will not be available for you 

(the + button is replaced with a refresh button) but the remaining 3 options are still valid.

When you start creating an expense or an income, you'll be presented with the following 

window:

Please note that you can easily customize which fields you see here and their order. See 

this guide for more information.

• Account: which account the transaction originates from. 
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• Amount: the transaction amount. By clicking on the currency code (in this case 

EUR) you can select a different currency from the enabled ones. 

• Description: something to help you identify what transaction is this or what it was 

for. 

• Payee: the merchant/person participating in the transaction. 

• Category: which expense/income category to assign this transaction to. Please 

remember that MoneyWiz uses separate list for expense and income categories. 

• Date and time: of this transaction. Click on the calendar icon to select the date 

with your mouse. 

When you start to create a transfer transaction, you'll see a window like this:

• From Account: the origin account – where the money is drawn from. 
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• To Account: the target account – where the money goes. 

• Transfer amount: how much money to transfer. Currency cannot be changed – 

the transfer will always be in currencies of the transfer accounts (if one of the 

accounts is in different currency, you will be able to change the exchange rate). 

• Description: something to help you identify what transfer is this or what it was for.

• Date and time: of the transfer. Click on the calendar icon to select the date using

a mouse. 

Please note that it is not currently possible to select a category for a transfer transaction. If

it was possible, in reports you'd see the sum of a category as zero (equal money going out

and in, resulting in net zero).

Section 2.2:How to edit transactions?

Once created, transactions can be easily edited.

MoneyWiz for Desktop (Mac and Windows) feature two view options: Fancy and Expert. 

You can switch between them using the button on the left-hand side:
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If the left button is selected, you are in Fancy view. In this view, you can edit 

transactions in two ways:

• single-click on a transaction row so it can expand and then click Options -> Edit, 

• double-click on a transaction row. 

If the right button is selected, you are in Expert view. In this view, you can edit 

transactions in two ways:

• right-click (or left-click while holding control key on your keyboard if you have right-

click disabled) on a transaction row and click Edit, 

• double-click on a transaction row. 

 A transaction window will open where you can modify all aspects of the existing 

transaction:
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Section 2.3:How to delete transactions?

If you decide that a transaction is no longer needed, you can delete it. Please note that it 

will change your account balance!

MoneyWiz for Desktop (Mac and Windows) feature two view options: Fancy and Expert. 

You can switch between them using the button on the left-hand side:
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If the left button is selected, you are in Fancy view. In this view, you can delete a 

transaction by single-clicking on the transaction row to expand it and then click on Options 

-> Delete.

If the right button is selected, you are in Expert view. In this view, you can delete 

transactions in two ways:

• right-click (or left-click while holding control key on your keyboard if you have right-

click disabled) on a transaction row and click Delete, 

• single-click on a transaction row to select a transaction then use a keyboard 

shortcut: ⌘ cmd + Backspace (on Mac) or Control + Backspace (on Windows). 

Section 2.4:How to adjust account balance?

Adjusting account balance will add an expense or an income to your account, depending 

on what amount you wish to adjust the balance for. This means that if the desired account 
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balance is lower than your current balance, MoneyWiz will add an expense to compensate

the difference. The adjust balance transaction that will appear cannot be categorized, 

tagged or modified (although it can be deleted at any time) so whenever possible, you 

might want to add regular transactions instead.

There are 3 ways of adjusting your account balance:

• click on the + button in the bottom-right and then select Adjust balance, 

• go to File menu bar item on top of the screen -> New -> Adjust balance, 

• right-click (or left-click while holding control key on your keyboard if you have right-

click disabled) on the account name in the sidebar and select Adjust balance. 

If this account is connected to Online Banking, the first option will not be available (the 

button will be changed to a refresh button) but the remaining two will still be accessible.

In the window that opens, enter the desired account balance that MoneyWiz should set for 

this account – remember that the new balance can be either positive or negative. If 

needed, you can also add some description to the adjustment. Please note that it is not 

currently possible to set a date and time for the adjustment – it will always be created with 

the current date and time.
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Once created, adjust balance transactions cannot be modified or moved to a different 

account – but they can be deleted, just like any transaction.

Section 2.5:How to create transactions with checks?

If you have a checkbook that you use to issue checks, you might want to record the check 

numbers in MoneyWiz. In order to do this, you first need to enable this feature.

Enabling the checkbook for your accounts
The checkbook register has to be enabled per account. This means that you might enable 

it for one account but not for the other.

Please note that it is enabled by default for newly created accounts if your local currency is

set to USD.
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In order to verify that the checkbook register is enabled for your account or enable it, start 

editing your account. There are two ways of doing this:

• double click on the account name in the sidebar, 

• right-click (or left-click while holding control key on your keyboard if you have right-

click disabled) on the account name in the sidebar and select Edit. 

Once the account properties window opens, either swipe to the left on your track pad or 

use the tabs on top to switch to Extended tab (you can also click on the small circles at the

bottom).

In order to make it possible to enter checks in this particular account, this check box needs

to be checked. In order to disable the feature, remove the check. Once you make your 

changes, click Done.
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Entering checks when entering transactions
Start creating new transaction or open an existing one for editing. Depending on your 

Transaction layout settings, you might see the check number field immediately or you 

might need to click on the Show all label to reveal hidden fields.

You can type the check number here or click the + button to have MoneyWiz automatically

issue the next check number for you.

Please note that it is currently not possible to reset check number count.

Section 2.6:How to duplicate a transaction?

Duplicating a transaction allows you to create a duplicate of an existing transaction that 

you can then either leave as an exact duplicate or modify to change some elements of it. 
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This guide explains how to duplicate transactions and also why the transaction date 

sometimes gets changed while duplicating transactions.

MoneyWiz for Desktop (Mac and Windows) feature two view options for transactions: 

Fancy and Expert. You can switch between them using the button on the left-hand side:

If the left button is selected, you are in Fancy view. In this view, you can duplicate 

transactions by single-clicking on a transaction row to expand it and then click on the 

Duplicate button.

If the right button is selected, you are in Expert view. In this view, you can duplicate 

transactions by right-clicking (or left-clicking while holding control key on your keyboard if 

you have right-click disabled) on a transaction row and click Duplicate.

You'll then be presented with a new transaction window, pre-filled with details of the 

original transaction. You can either leave it as it is and save the transaction or change 

some details of it before saving.

Page 63 out of 172



Section 2.6:How to duplicate a transaction?

Why is the duplicate transaction date sometimes the same 
and sometimes different compared to the original 
transaction?
If the most recent transaction in your account is older than 14 days, we consider that the 

entire account is not up to-date and we show the date of the original transactions when 

duplicating.

If the most recent transaction is less than 14 days in the past (or today, or in the future – it 

doesn’t matter how far in the future though) we consider the account up to-date. So when 

you duplicate, by default we use today's date.

Section 2.7:How to refund or reimburse transactions?

If you were partially or fully refunded for something, you should log it in MoneyWiz to 

properly display your account balance. In MoneyWiz, we differentiate between two types of

such operations:

• refund – full or partial refund for a single, particular transaction (e.g. when you 

return an item to a store for a refund), 

• reimbursement – a full or partial reimbursement for a series of transactions for a 

particular expense category (e.g. you use your company car and use your own 

money to fuel it up but every once in a while your company issues you a 

reimbursement for that cost). 

This guide explains how to enter each of those into MoneyWiz and how to convert an 

existing income transaction to a refund.
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Creating refunds
In order to create a refund, you need to have an existing expense that the refund is for. If 

you were refunded for multiple transactions in one go, you need to create a 

reimbursement instead (see below).

To create a refund, find the expense you were issued a refund for. Once you locate it, you 

need to select it and select the refund option.

MoneyWiz for Desktop (Mac and Windows) feature two view options: Fancy and Expert. 

You can switch between them using the button on the left-hand side:
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If the left button is selected, you are in Fancy view. In this view, you should click on a 

transaction row once to expand it and then click Options -> Refund to refund a transaction.

If the right button is selected, you are in Expert view. In this view, you should right-click 

(or left-click while holding control key on your keyboard if you have right-click disabled) on 

the transaction row and select Refund.

A transaction window will open:

If you were refunded full amount, leave the amount as it is (it defaults to 100% refund). If 

you were refunded a partial amount, change the amount to the value you've been issued a

refund for.
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Converting existing incomes to refunds

In case your refund has already been imported into MoneyWiz (either via Online Banking 

or manual bank statement import), you can use "Convert to refund" feature in MoneyWiz to

properly log it inside the application.

To begin locate your income and then – using the tips above for your view setting (Fancy 

or Expert):

if using Fancy view: click once on the transaction row to expand it and then click Options -

> Convert to Refund,

• if using Expert view: right-click once on the transaction row and select Convert to 

Refund. 

You'll be presented with a window with a list of your expenses – please locate the expense

that this is a refund for.

Creating reimbursements
When you create a reimbursement, it's like you are creating a refund for the entire 

expense category. For this reason, you don't refund one particular transaction – if that's 

what you need to do, you should create a refund instead (see above).

To create a reimbursement, please start creating an expense transaction. Select the 

expense category you want to reimburse, the reimbursement date and so on. The major 

difference between creating a reimbursement (and not a regular expense) is the amount – 

you need to enter it with a minus sign (a negative expense). So if you were reimbursed for 

$50, you should enter the amount as -50 USD.

Converting existing incomes to reimbursements

To convert an existing income transaction to a reimbursement, open the transaction for 

edit and use the tabs on top to convert it to an expense. You'll notice that most of the fields

remained the same but you'll need to adjust two of them:
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• click on the amount field to add a minus (so $50 becomes -$50), 

• set the expense category to reimburse. 

Save the modified expense transaction and your reimbursement is created.

Section 2.8:How to reconcile transactions?

What is reconciliation? What does it mean to reconcile a transaction? When you reconcile 

transactions, you double-check that the transactions you have in MoneyWiz match the 

ones you see on your bank. This can help you find accounting errors or fraud. This guide 

will teach you how to reconcile transactions.

There are two ways of reconciling your transactions.

Advanced reconcile (recommended)
This feature is available only in MoneyWiz for Desktop (Mac and Windows).

To enter Advanced reconcile, click on the scales button in the top-right:
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Regardless of what view you were in, you'll be switched to Expert spreadsheet mode that 

features a special bar on top:
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As for the fields you see:

• Opening date: in this field you set the start date of your bank statement. 

• Closing date: this is where you should enter the end date of your bank 

statement. 

• Opening balance: here you enter the starting balance of your statement. 

• Closing balance: is the place for ending balance of your bank statement. 

MoneyWiz will try to populate all those fields for you but you can change them at any time. 

For example, when you enter Reconcile mode MoneyWiz by default sets the Opening date

as the date of the last reconciled transaction + 1 day, while the Closing date is 30 days 

later. This means that if the date of your last reconciled transaction in this account is 

January 5, MoneyWiz will automatically set the Opening date of reconciling as January 6 

(a day after last reconciled transaction) and the Closing date as February 4 (30 days after 

the last reconciled transaction).

MoneyWiz also tries to identify the correct balances for opening and closing balance. If 

you are reconciling regularly, this should always be a match. If it's not, you should carefully

check what is the reason for the difference.

Please also note that MoneyWiz will show unreconciled transactions from the previous 

statement periods as you may find it useful to make sure there are no missed transactions 

between the current and the previous statement.

At the bottom of the box, you have two check boxes that allow you to control the visibility 

of transactions of certain types. By default, MoneyWiz will display any transactions within 

the specified range (Opening date – Closing date) but you can control it here.

Now let's talk about the small progress bar and values around it:
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• 0 reconciled: this means that no transactions have been reconciled so far. If I 

were to reconcile one transaction, this number would change to 1. 

• 3 unreconciled: this is how many transactions remain unreconciled within the 

given period. 

• 116,94 EUR left to reconcile: similar to above, this tells me how much money

in general I still have to reconcile. 

Clicking Done closes Advanced reconcile but it doesn't really save your changes – that's 

because changes are saved immediately, as you reconcile each transaction.

In order to reconcile, all you need to do is simply place a tick next to transactions that you 

were able to locate on your bank statement. You'll notice that as you do this, the values 

change:

I have 1 unreconciled transaction for 15 EUR and MoneyWiz tells me that there is 15 EUR 

in total left to reconcile. Looks like yet another seamless reconciling session!
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It is possible however that at some point you'll see a red "n left to reconcile" label:

This means that there's a problem somewhere. You should begin by double-checking:

1. Whether the Opening date is correct. 

2. Whether the Closing date is correct. 

3. Whether the Opening balance is correct. 

4. Whether the Closing balance is correct. 

5. If the above fails, try unreconciling all transactions and start again, carefully looking 

for possible problems within transactions themselves. 

In this particular case, Opening balance was off by 0,01 EUR. Ah, silly me! Changing 

Opening balance back to 1 500,00 EUR fixed the problem. Naturally, it might be worth 

checking why the Opening balance was incorrect. In this case, I was entering it manually 

so I assume human error.

Please note that your reconciling Closing balance does not have to be equal to your 

current account balance. If your reconciling Closing date is today and you have no future 
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transactions in the register then indeed those figures should be equal. But if you're 

reconciling older transactions month by month then remember that the Closing balance will

be automatically set to account balance on the date of Closing date.

Regular reconcile method
We highly recommend using the Advanced Reconcile (Reconcile Assistant) in MoneyWiz 

for Desktop. However, you might prefer simpler method. To begin, switch to Expert view:

You should see a column with check boxes on the far left side. If not, try changing your 

column layout by right-clicking (or left-clicking while holding control key on your keyboard if

you have right-click disabled) on the column headers and enabling Reconcile column.

To reconcile in this mode, simply put a tick next to transactions you see on your bank 

statement. There's no period to set and MoneyWiz won't verify the opening or closing 

statement balance for you.

Section 2.9:How to create split transactions?

Split transactions allow you to split the amount among different categories and/or 

accounts. Please note that advanced split feature – where you can split the amount among

different transaction types (e.g. paycheck where you have an income and tax deductions) 

is not yet supported but we're working on bringing this feature to MoneyWiz.

Page 73 out of 172



Section 2.9:How to create split transactions?

Splitting transactions among different categories
To begin, either start creating new transaction or modify an existing one. Then click on 

Categories field to bring up the list of categories. At the very top of the list, you should see 

the following:

With this check box empty, selecting one category will de-select the previous one so you'll 

be able to keep just one selected at a time. If you wish to select multiple categories to 

participate in your split, please put a check in this box and then proceed to click on 

transactions you want to add to the split.

Once all categories are selected, fill out the remaining details of the transaction and click 

Next (notice that the Save button that's usually placed in the bottom-right corner was 

changed to Next). When you proceed, you'll be asked to assign specific amounts to each 

split:

Page 74 out of 172



Section 2.9:How to create split transactions?

The sliders on the left allow you to change the amounts (without detailed control). To 

control the amounts precisely, type them in the amount boxes. Once you modify an 

amount, the padlock icon on the right will change to red, signaling that the amount is now 

locked – it won't be modified again as you're changing the amounts of other splits. You can

always unlock it by clicking on the padlock icon but this might cause the current amount to 

be lost.

If needed, you can also change the total amount without going back using the box on top.

Once you set everything as you need, click Save and the category icon for this transaction 

will change to highlight that it's a split transaction:
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Splitting transactions among different accounts
You can also split transactions among different accounts. When creating a transaction, just

click on the accounts field and tick the check box – it works just like when splitting 

transaction among different categories:

Additional notes:
• It is not currently possible to split transactions among expense and income 

categories at the same time. 

• It is not currently possible to split transactions among different payees or tags. 

• When splitting transactions among different accounts and categories at the same 

time, you cannot decide which part of the category split goes to which account. You 

simply split the amounts between the accounts and categories separately. 
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Section 2.10: How to bulk-edit transactions?

Bulk-edit of transactions allows you to modify multiple transactions at the same time, 

saving a lot of time changing the details of many transactions. This feature is currently only

available in MoneyWiz for Desktop (Mac or Windows).

To begin, you need to switch to Expert view, where transactions are listed in rows and 

columns:

Once you switch to Expert view, you can start selecting multiple transactions. There are 

few ways of doing this:

Selecting a single transaction
Click once on a transaction row to select it. If you click on another transaction row, the 

previous one will get deselected.
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Selecting multiple transactions
If you need to select multiple transactions that are scattered around your account register, 

click once on them while holding ⌘ cmd key on Mac or control key on Windows.

If you hold this key while clicking on a transaction row once, MoneyWiz will add the 

transaction you're clicking on to the previous selection.

Selecting multiple transactions in a range
If the transactions you need to select are next to each other, do the following:

1. Click on the first transaction in a group (could be the first or last) without holding 

anything. 

2. Press and hold ⇧ Shift key on your keyboard and click on the transaction row in the 

opposite location (if you first selected the first transaction in a group, select the last 

one now). 

3. Release the ⇧ Shift key. 

What this will do is select the first transaction you clicked on, the second transaction you 

clicked on and all transactions in between the two.

You can do a similar thing using your keyboard:

1. Click on a transaction. 

2. Press and hold ⇧ Shift on your keyboard and keep pressing the up or down arrow 

on your keyboard until you select all transactions you need. 

3. Release the ⇧ Shift key. 

Select all visible transactions
You can also select all visible transactions. This is especially powerful if you've just 

searched for some transactions (e.g. for a particular payee) and you need to modify them 

all.
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1. Click on one of the visible transactions (doesn't matter if it's first, last or in the 

middle). 

2. Press this combination of keys on your keyboard: ⌘ cmd + A on Mac or control + A 

on Windows. 

That's it! All visible transactions have been selected.

Editing selected transactions
To edit all selected transactions, you need to right-click on one of them (or left click while 

holding control key on your keyboard if you have right click disabled). You can then 

choose to Edit the transactions, Delete them and more.

You can also left-click on them once, hold the mouse button down and drag them – for 

example, to move them to a different account.

Bulk-edit limitations
• This feature is currently only available in MoneyWiz for Desktop (Mac and 

Windows). 

• It is not possible to bulk-edit transactions of different type (e.g. modify an expense 

and income at the same time – you need to first edit the expenses and then edit the 

incomes). 

• It is not possible to bulk-edit these types of transactions: adjust balance, transfers, 

refunds and investment/forex/crypto trades. 
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Section 3.1:What are transaction categories?

Transaction categories are one of the transaction properties that you can set. There is a 

separate list of categories for expenses and a separate list for incomes. On first use, 

MoneyWiz creates a default list of categories for you but you can easily create new ones, 

modify existing or delete the ones you don't need.

If you go to two shops – let's say Tesco and Walmart – to buy groceries, you will have 

different payees for each of those transactions but the same category: groceries. This 

allows you to generate category-based reports to see how much you're spending on 

groceries overall, regardless of the shop you're buying in (of course, it is possible to 

customize the report to filter some things out).

Section 3.2:How to create new transaction 
categories?

There are two ways to create transaction categories: while creating transactions and inside

MoneyWiz Settings.

During transaction creation
This method is quick and easy but you can't choose too many details of the category (but 

you can easily modify it later). To begin, start creating new transaction or modifying an 

existing one and then click on Category field. Type in the search bar the name of the 

category – if it doesn't exist, MoneyWiz will present you with an option to create it. It'll be 

created with default icon and placed as the main category. You can change the details of it

later.
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In MoneyWiz Settings
This allows you more control over all the small details. To create new transaction 

categories, first go to MoneyWiz Settings. You can get there using one of the three ways:

• click on the gear icon in the bottom-left corner of the screen, 

• press this combination of keys on your keyboard: ⌘ cmd + on Mac or control + , on 

Windows (that's a comma), 

• on Mac, click on MoneyWiz menu bar item in the top-left and then Settings. 

Once you're in Settings view, click on Categories tab. You'll see something like this:

To start creating a new category, use the New category button in the bottom-left. 

Remember, expense and income categories are separate so if you need to create an 

income category, first use the tabs on top to switch to income categories.
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You'll be asked for:

• The category name: anything that is useful for you in recognizing the 

transaction. 

• Whether it's a subcategory of something: if no (if it should be a main 

category), leave this empty. But if this should be a sub-(or sub-sub-sub?) category 

of something, click on this button and select the main category. If while clicking New

category you had some category selected on the list, MoneyWiz would 

automatically select that category as the main one for you. 

• Category color: only if you have colorful categories enabled in transaction layout

settings. 

• Category icon: pick one from the available ones. It is not currently possible to 

use custom icons for categories. 

The category will be created when you click Create.

Section 3.3:How to edit transaction categories?

To edit existing transaction categories, first go to MoneyWiz Settings. You can get there 

using one of the three ways:

• click on the gear icon in the bottom-left corner of the screen, 

• press this combination of keys on your keyboard: ⌘ cmd + on Mac or control + , on 

Windows (that's a comma), 

• on Mac, click on MoneyWiz menu bar item in the top-left and then Settings. 

Once you're in Settings view, click on Categories tab. You'll see something like this:
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Double-click on the category you wish to edit or click on it once and then click Edit button. 

If you need to edit a sub-category, please click on the little triangle to the left to expand the

sub-category list to be able to view it.

Remember that if you wish to change the category colors, you need to first ensure that 

colorful categories are enabled in Transaction layout settings.

Section 3.4:How to delete transaction categories?

MoneyWiz allows you to easily delete existing transactions. What's even better, MoneyWiz

will first check if that category is completely unused (in that case, it'll just ask you if you are

sure you wish to delete the category) or if perhaps it's already used in some transactions 
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(in that case, it'll offer you to merge the category with another one before deletion). Read 

on to learn how to do this.

To delete transaction categories, first go to MoneyWiz Settings. You can get there using 

one of the three ways:

• click on the gear icon in the bottom-left corner of the screen, 

• press this combination of keys on your keyboard: ⌘ cmd + on Mac or control + , on 

Windows (that's a comma), 

• on Mac, click on MoneyWiz menu bar item in the top-left and then Settings. 

Once you're in Settings view, click on Categories tab. You'll see something like this:
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To delete a category, click once on it to select it and click on the Delete button. If you need

to delete a sub-category, click on the little triangle to the left to expand the sub-categories 

list.

Depending on whether the category is used in at least one transaction (at least one 

transaction has been assigned this category), MoneyWiz will do one of the following:

• ask you whether you are sure to delete you wish to delete it: 

If you see this, this category does not have any transactions associated with it and it's safe

to delete.

• offer you to merge it before deletion: 
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If you see this, there is at least one transaction that is using this category.

If you keep "Delete category" selected and click Done, MoneyWiz delete the category and 

remove this category from the transactions it's being used at (making them 

uncategorized).

If you select "Merge & Delete", MoneyWiz allow you to pick another category from the list. 

Any transactions that are using the category you're about to delete will be re-categorized 

to the category you've selected before the category is deleted.

If you need to merge the category you're deleting with a category that does not yet exist, 

don't delete it! Simply edit the existing category to change its name, icon and more.
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Section 4.1:What are transaction payees?

Payees are one of the transaction properties that you can modify. They are used to denote

the merchant/institution/person participating in the transaction. So if you make a purchase 

at Whole Foods, you'd enter the payee as "Whole Foods" each time you buy something 

there. This would allow you to later generate a report to see how much you've spent in 

total in that shop (or combine it with other transaction properties, such as categories, to 

generate even more meaningful reports).

Please note that for simplicity, we are calling this transaction property Payee both for 

expenses and incomes. However, in both of those cases, you should use the Payee to 

denote the other party: the one you're paying to for expenses and the one that's paying 

you in incomes.

Section 4.2:How to create new transaction payees?

There are three ways of creating transaction payees that we'll go through here.

Creating Payees via Settings
This is probably the method you'll use least often. To create new transaction categories, 

first go to MoneyWiz Settings. You can get there using one of the three ways:

• click on the gear icon in the bottom-left corner of the screen, 

• press this combination of keys on your keyboard: ⌘ cmd + on Mac or control + , on 

Windows (that's a comma), 

• on Mac, click on MoneyWiz menu bar item in the top-left and then Settings. 
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Once you're in Settings view, click on Payees tab. You'll see something like this:

To create new payee using this window, click on New button and enter the payee name. 

You'll then be able to choose it from the list during transaction creation.

Creating Payees while creating transactions
Far easier and quicker method is to create payees right from the transaction creation 

window. When creating or modifying a transaction, just type in the Payee field. Once you 

click Save, if the payee you've typed does not exist, it will be created.
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Creating Payees while importing transactions
Both manual statement import as well as automatic Online Banking import feature have 

the capacity to create new payees for you. It is discussed in more details in other guides 

that relate to those features in detail.

Section 4.3:How to edit transaction payees?

If you've decided to change the name of the payee in MoneyWiz, you don't need to go 

through each individual transaction to change the payee name there. You can just change 

the name in one place and all transactions will update automatically.

To create new transaction categories, first go to MoneyWiz Settings. You can get there 

using one of the three ways:

• click on the gear icon in the bottom-left corner of the screen, 

• press this combination of keys on your keyboard: ⌘ cmd + on Mac or control + , on 

Windows (that's a comma), 

• on Mac, click on MoneyWiz menu bar item in the top-left and then Settings. 

Once you're in Settings view, click on Payees tab. You'll see something like this:
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To modify a payee either double-click on it or click once to select it and then click on Edit 

button.

Section 4.4:How to delete transaction payees?

To delete existing transaction payees, first go to MoneyWiz Settings. You can get there 

using one of the three ways:

• click on the gear icon in the bottom-left corner of the screen, 

• press this combination of keys on your keyboard: ⌘ cmd + on Mac or control + , on 

Windows (that's a comma), 

• on Mac, click on MoneyWiz menu bar item in the top-left and then Settings. 
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Once you're in Settings view, click on Payees tab. You'll see something like this:

To delete a payee, click on it and click Delete button. MoneyWiz will ask you if you are 

sure. If you proceed, the payee will be deleted and removed from any transactions that 

might be using it. MoneyWiz does not check whether the payee is used or 

not so please check this yourself before deleting the payee (for example by generating a 

payee report for all time period).
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Section 5.1:What are transaction tags?

Tags are one of the transaction properties that you can modify. Tags need to be enabled 

via transaction layout settings before they can be used. Each transaction can have more 

than one tag assigned.

Tags become useful when you are tracking transactions related to a single project: a 

wedding, a trip or something like home-improvement. For example, you might eat at 

McDonald's while at home (transaction has McDonald's payee and Eating out category) 

but also during your trip to Paris. In the first case, you'll most likely not assign any tag but 

for the second case, you might want to assign some tag like "Trip to Paris" to bring all trip-

related expenses together – allowing you to generate a report at the end of the trip, 

reviewing how much you've spent overall.

Section 5.2:How to create new transaction tags?

There are two ways of creating transactions: during transaction entry and via MoneyWiz 

Settings. Please remember that in order to use tags, you need to have them enabled in 

Transaction layout settings.

Creating tags during transaction creation
To create tags during transaction creation, start creating a new transaction or modify an 

existing one and then type in the transaction tags field. If the tag you've typed does not 

exist, it will be created.
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Creating tags via MoneyWiz Settings
To create new transaction tags, first go to MoneyWiz Settings. You can get there using 

one of the three ways:

• click on the gear icon in the bottom-left corner of the screen, 

• press this combination of keys on your keyboard: ⌘ cmd + on Mac or control + , on 

Windows (that's a comma), 

• on Mac, click on MoneyWiz menu bar item in the top-left and then Settings. 

Once you're in Settings view, click on Tags tab. You'll see something like this:

To create a new tag, click the New button and enter a name.
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Section 5.3:How to edit transaction tags?

To edit existing transaction tags, first go to MoneyWiz Settings. You can get there using 

one of the three ways:

• click on the gear icon in the bottom-left corner of the screen, 

• press this combination of keys on your keyboard: ⌘ cmd + on Mac or control + , on 

Windows (that's a comma), 

• on Mac, click on MoneyWiz menu bar item in the top-left and then Settings. 

Once you're in Settings view, click on Tags tab. You'll see something like this:

To modify a transaction tag, double-click on the tag or click once to select it and then click 

on Edit button.
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Section 5.4:How to delete transaction tags?

To delete existing transaction tags, first go to MoneyWiz Settings. You can get there using 

one of the three ways:

• click on the gear icon in the bottom-left corner of the screen, 

• press this combination of keys on your keyboard: ⌘ cmd + on Mac or control + , on 

Windows (that's a comma), 

• on Mac, click on MoneyWiz menu bar item in the top-left and then Settings. 

Once you're in Settings view, click on Tags tab. You'll see something like this:

To delete a tag, click on it and click Delete button. MoneyWiz will ask you if you are sure. If

you proceed, the tag will be deleted and removed from any transactions that might be 
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using it. MoneyWiz does not check whether the tag is used or not so please 

check this yourself before deleting the tag (for example by generating a tag report for all 

time period).
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Section 6.1:What are Scheduled transactions? How 
can I use them?

Scheduled transactions are basically transaction templates that can either be executed 

when you click on them or be executed automatically on a given date and time. These 

allow you to stop worrying about recurring transactions such as your income, bills, rent or 

even transfers to saving accounts.

They are extremely useful if you don't use our automatic Online Banking feature and are 

entering transactions manually–if those transactions happen regularly, you can schedule 

them and have MoneyWiz enter them for you! Remember that Scheduled transactions do 

not need to be recurring–you can also use them to schedule one-off transactions or 

transactions that do repeat, but only for a finite amount of time.

But even if you're using Online Banking feature to automatically download transactions 

you can benefit from setting up your Scheduled transactions. They will provide you with 

great forecasting insights and allow you to see how your balance would look like if all 

Scheduled transactions were executed today.

Section 6.2:How to create Scheduled transactions?

To create a new Scheduled transaction (which can be an expense, an income or a 

transfer), please first switch to Scheduled transactions section (using the buttons in the 

sidebar on the far left). Once you're in this view, you can create Scheduled transactions in 

three ways:

• click on the + button in the bottom-right corner and select transaction type, 
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• use the keyboard shortcut (you need to be in Scheduled section in order for this to 

work),

• ⌘ cmd + E on Mac or control + E on Windows for an expense, 

• ⌘ cmd + I on Mac or control + I on Windows for an income, 

• ⌘ cmd + T on Mac or control + T on Windows for a transfer, 

• go to File menu bar item on Mac and select New -> and select transaction type. 

This will present you with a window where you can fill out the Scheduled transaction 

details. If you wish to use an existing transaction as a template, please find that 

transaction first. MoneyWiz for Desktop (Mac and Windows) feature two view options for 

transactions: Fancy and Expert. You can switch between them using the button on the left-

hand side:
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If the left button is selected, you are in Fancy view. In this view, you can set 

transactions as scheduled by single-clicking on a transaction row to expand it and then 

click on the Options button and finally Make Scheduled.

If the right button is selected, you are in Expert view. In this view, you can set 

transactions as scheduled by right-clicking (or left-clicking while holding control key on 

your keyboard if you have right-click disabled) on a transaction row and click Make 

Scheduled.

You'll then be presented with a new transaction window, pre-filled with details of the 

original transaction. You can either leave it as it is and save the transaction or change 

some details of it before saving.

Let's now review the possible options that are visible when creating a scheduled 

transaction:
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• Using the tabs on top you can change the transaction type: expense, income or a 

transfer. 

• Account: select the account participating in the transaction. 

• Amount: set the value for the transaction. Click on the currency code if you need a

different currency. 

• Description: some text to go with your transaction, reminding you what it is for. 

• Payee: the merchant/institution/person participating in the transaction. 

• Category: the category to go with this transaction. 

• Date and time: the date and time that this transaction is scheduled for. 

• Auto-pay: (only visible in accounts that are not connected to Online Banking) the 

transaction will be automatically created once the date and time set above is due. 

• Auto-skip: (only visible in accounts that are connected to Online Banking) on the 

due date, MoneyWiz will check if a similar transaction is already present in your 

account. If not–it will post it. If yes, it'll skip the scheduled instance in order not to 

post a duplicate. 

• Repeat: whether the transaction should repeat regularly or not. 

• Frequency: (only visible for repeating transactions) how often the transaction 

should repeat. You can type in the text box to change how often and you can click 

on the "Months" button to change the period: choose from days, weeks, months and

years. 

• End: when (and whether) the transaction should eventually stop repeating. Select 

"Never" for transactions you don't foresee to end anytime soon (e.g. your internet 

bill) because you can always delete them later if needed. For transactions that you 

know the duration of, select the number of repeats. The number of repeats you set 

will be the total number of transactions this Scheduled transaction will produce 

before ending. 
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Click on Save to close the transaction creation window and save the transaction. If the 

transaction date and time you've selected was in the past, MoneyWiz will immediately act 

on the transaction (e.g. paying it, if the "auto-pay" setting was enabled).

A couple of notes:

• if the transaction is repeating, it will repeat regularly on the date and time set in the 

date and time field (e.g. 5th July -> 5th August), 

• at this time it is not possible to schedule a transaction other than specific date and 

time. This means that it is not possible to schedule it for 3rd Wednesday of the 

month for example. 
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Section 6.3:How to edit Scheduled transactions?

In order to edit Scheduled transactions, please first switch to Scheduled transactions 

section using the buttons on the far left side of the sidebar. Please note that it is not 

possible to edit a Scheduled transaction simply by editing the transaction it produces. 

Scheduled transactions are like templates that create a copy of themselves when the time 

is due. Once the copy is produced, the created transaction is not aware that it was created

by a Scheduled transaction and therefore is completely separate from it.

Once you've switched to Scheduled transactions section, notice that your transactions are 

listed as little squares below the calendar:

To edit one of the scheduled transactions, left-click on it once so that the contextual menu 

can appear, from which choose Edit. You'll be presented with a transaction window, where

you can edit the properties of this transaction.
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There is one important thing to note changes you make here will apply to the next and all 

future occurrences of the transaction. If you want to make changes to just the next 

occurrence only, please click on the Scheduled transaction box and select Pay instead. 

Please note that the transaction will be executed after you save your changes so you 

might want to wait until the transaction is actually due before you do this.

Section 6.4:How to duplicate Scheduled transactions?

Duplicating Scheduled transactions allow you to quickly create a copy of what you're 

looking at and either leave it as an identical copy or introduce some small changes.

In order to duplicate Scheduled transactions, please first switch to Scheduled transactions 

section using the buttons on the far left side of the sidebar. Please note that it is not 

possible to duplicate a Scheduled transaction simply by duplicating the transaction it 

produces. Scheduled transactions are like templates that create a copy of themselves 

when the time is due. Once the copy is produced, the created transaction is not aware that

it was created by a Scheduled transaction and therefore is completely separate from it.

Once you've switched to Scheduled transactions section, notice that your transactions are 

listed as little squares below the calendar:
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To duplicate one of the Scheduled transactions you see, left-click on the box once and 

select Duplicate from the contextual menu that appears.

You'll see a transaction entry window with details already filled out from the original. You 

can make some changes or leave it as it is. Remember–because this is a brand new 

transaction, the Start date will be the real start date of this new transaction so make sure 

to set it to the next occurrence of this duplicate.

Section 6.5:How to delete Scheduled transactions?

Deleting a Scheduled transaction will stop any further occurrences of it but it will not delete

the transactions that were created by it.

In order to delete Scheduled transactions, please first switch to Scheduled transactions 

section using the buttons on the far left side of the sidebar. Please note that it is not 

possible to delete a Scheduled transaction simply by deleting the transaction it produces. 

Scheduled transactions are like templates that create a copy of themselves when the time 
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is due. Once the copy is produced, the created transaction is not aware that it was created

by a Scheduled transaction and therefore is completely separate from it.

Once you've switched to Scheduled transactions section, notice that your transactions are 

listed as little squares below the calendar:

To delete a Scheduled transaction, click on the box that you wish to delete and select 

Delete from the contextual menu.

Section 6.6:Should I create Scheduled transactions if 
I’m using Online Banking?

Short answer: yes!

Scheduled transactions make Forecast reports meaningful. For example, if you have a 

scheduled transfer from your checking account to savings, Forecast report would allow 

you to see how much money you'll have in 6 months.
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Our suggestion is to create Scheduled transactions for all transactions that are recurring 

and simply enable auto-skip if the transaction is happening in an Online Banking-enabled 

account. This will take care of the duplicates for you.

Section 6.7:How does auto-pay work? What does it 
do?

Auto-pay is one of the options you will see when creating Scheduled transactions. Please

note that you will only see this option if the account you've picked for your Scheduled 

transaction is not connected to Online Banking.

Auto-pay should not be confused with auto-skip (explained below).

If you have some transactions that occur regularly, with same amount each time (e.g. rent 

or salary), you might want to automate those transactions so they get posted into your 

Account register automatically as they become due.

In order to do this, simply enable "auto-pay" when creating Scheduled transactions. This 

will cause that particular Scheduled transaction to get posted to your Account register 

automatically, if MoneyWiz is running or launched while the transaction became overdue 

(the due date of the transaction arrived).

Section 6.8:How does auto-skip work? What does it 
do?

Auto-skip is one of the options you will see when creating Scheduled transactions. 

Please note that you will only see this option if the account you've picked for your 

Scheduled transaction is connected to Online Banking.

Auto-skip should not be confused with auto-pay (explained above).
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Creating Scheduled transactions makes sense even if you have connected the account to 

Online Banking. It's explained in more detail here.

But with transactions coming to your Account register from Online Banking sync and 

Scheduled transactions creating transactions automatically as they become due, how does

MoneyWiz prevent duplicates from appearing? The answer is auto-skip.

When a Scheduled transaction with auto-skip enabled becomes due it'll check if the 

transaction is downloaded already. It checks it by looking for a transaction with exactly 

the same amount and transaction date within 3 days (either way–to account for 

weekends).

If it finds one, it will not post the duplicate transaction but will update the downloaded one 

with information from Scheduled transaction if necessary.

If it does not find one, it will post the Scheduled transaction in order to make your balance 

correct. Later, when MoneyWiz will be downloading Online Banking transaction, it'll look 

for duplicates using the same rules as above.

Therefore the only way a duplicate might appear as a result of this is if your date is not 

within 3 days period or the amount is not exactly the same. If you are frequently seeing 

duplicates as a result of auto-skip feature, your transactions probably miss the conditions 

specified above. In that case, you might be better off with auto-skip disabled. In this setup, 

MoneyWiz will not pay or skip the transaction automatically–it'll just leave it with a red 

badge when it becomes due. You can then skip the transaction manually.

Section 6.9:How to create pay checks including tax, 
insurance, etc? 

When you get paid by your employer, the amount of money you receive is less than what 

you are paid due to social/institutional deductions such as tax, insurance, health and other 
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benefits, retirement (401k) contributions and so on. You might be wondering how to 

properly record this in MoneyWiz. This guide deals with this problem.

Sadly, at this time MoneyWiz does not support splits among different types of transactions.

This means that you'd need to record your income and deductions separately. Here's how 

you could do this:

1. Record a Scheduled income for the date you're usually paid. For the amount enter 

the full amount that your employer pays out. 

2. Record a separate Scheduled expense for all the deductions you're paying. This 

could either be a single expense for all deductions (a split transaction) or you could 

record a separate expense for each deduction. The date of those scheduled 

deductions should be the date of your income. 

If you're not using Online Banking, the transactions can be automatically paid to 

immediately reflect your account balance after you've been paid. If you are using Online 

Banking, we recommend that you disable auto-skip and just manually skip the transactions

once the transactions download from Online Banking (because the income amounts won't 

match, MoneyWiz will not know that it is the same transaction).
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Section 7.1:What are budgets? How can I use them?

Budgets allow you to keep your spending in control. You could create one major budget 

and just stick with it, or you could create individual budgets for each spending type 

(Groceries, Transport, Kids, Entertainment, etc). You might have seen us referring to 

accounts as containers for transactions and account groups as containers for accounts. 

Continuing with this notion, budgets can be described as containers for transactions that 

meet a certain criteria.

Let's say that you want to start controlling your spending in various areas. To achieve this, 

think about how you could organize your spending in envelopes. In some envelopes, you 

might want to go into more detail, whereas in others, an umbrella term will suffice. For 

example:

• Food 

• Regular bills 

• Rent 

• Household bills (electricity, heating, water) 

• Internet and TV 

• Mobile phone 

• Transportation 

• Entertainment 

Notice how we got into details when it comes to regular bills but for other categories, we 

were pretty generic. Of course, the final look of the envelope (budgets) layout is up to you.

Now that we have it all laid out, we can start creating budgets. Because budgets in 

MoneyWiz cannot have a hierarchy or be grouped, we'll end up with the following budgets:
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• Food 

• Rent 

• Household bills 

• Internet and TV 

• Mobile phone 

• Transportation 

• Entertainment 

The order naturally can be adjusted to your liking. When creating budgets, you'll have to 

select categories that the budget will monitor. Any expense that meets the budget criteria 

will appear in the budget, reducing the budget allowance for the current period. If needed, 

you can transfer available funds from one budget to another–which comes in handy if one 

of your household bills gets unexpectedly big this month and you need to cover for the 

deficit using your Entertainment funds for example.

Budgets can be repeating regularly if you wish or be one-offs (a wedding budget). 

Categories and accounts are the main filters that allow you to decide which transaction 

goes to which budget, but you can also use tags to classify them further (e.g. a taxi 

category expense with "Wedding" tag could get classified to your Wedding budget only, 

while a taxi category expense with "Personal" tag would not get assigned there). 

Moreover, you can either have the budgets remember the closing balance on their ending 

day (e.g. you had $15 left in your Entertainment budget that you didn't spend on anything) 

and include it in the next budget occurrence (+$15 to Entertainment allowance, on top of 

what you normally receive).

Section 7.2:How to create a budget?

You can create a budget in 4 ways:

• using menu bar on top, go to File -> New... -> New Budget... 
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• select the Budgets section from the sidebar and use the "New Budget" button in the 

middle (it'll be visible only if there are no budgets in your database at the time) 

• use the + button in the bottom-left corner of MoneyWiz window, at the bottom of the 

sidebar and select New Budget 

• use the following keyboard shortcut:  Shift +  cmd + B⇧ ⌘  on Mac or  Shift ⇧

+ Control + B on Windows. 

You'll see the following window asking you to fill out the budget details:

• Name: the name for your budget, helping you to identify the budget. 

• Amount: the allowance for the budget. If the budget is non-repeating (e.g. 

wedding), this amount is the total budget allowance. If the budget is repeating (e.g. 
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monthly bill allowance), this is the budget allowance until the budget renews (for 

monthly budget, this is the monthly allowance). 

• Accounts: accounts to monitor. In order for transaction to appear in the budget, 

the expense must be originating from one of the accounts you select here. You 

need to select at least one account. 

• Categories: categories to monitor. Just like with accounts, in order for the 

transaction to appear in the budget, the expense must be allocated to one of the 

categories you select here. You need to select at least one category. 

• Tags: tags to monitor. You can leave this field empty if needed. If you specify any 

tags here,  the budget will only display transactions that contain at least one of 

the specified tags. If you enter multiple tags here, MoneyWiz will not require that 

your transactions contain all of them–just one will suffice. In other words, the 

condition for multiple tags is OR, not AND. 

• Icon: in addition to the name, you can choose an icon for the budget to make it 

easier to identify. 

• Start date: when the budget should start analyzing transactions. You can set this 

date to be in the past and MoneyWiz will automatically populate earlier budget 

periods as needed. 

• Repeat: whether the budget should repeat. For one-off budgets, keep this 

unchecked. 

• End date: if the budget is non-repeating, you need to specify when it ends. 

• Frequency: if the budget is repeating, you can specify how often it repeats since 

the Start date. By default it's set to 1 Month. You can modify the "1" part by typing in

the field. To change the "Month" part, click on that button to choose from days, 

weeks, months and years. 

• Rollover: if the budget is repeating, you can decide whether outstanding balance 

at the end of the budget period (positive or negative) will be included in the next 
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budget period's balance. If disabled, on each budget renewal date, the budget 

allowance will be equal to "Amount". 

• Carried balance: sometimes you might want to note that you've already spent 

some amount of the budget allowance (or have bit more). If you leave this at zero, 

the budget will be created with the "Amount" field in mind. If you enter here a 

positive or negative amount, MoneyWiz will sum it with the "Amount" field. This 

setting requires the rollover to be enabled. 

Once you create a budget, MoneyWiz will scan existing transactions if they fit the budget 

criteria (start date, account, category, tags, etc). If yes, it'll apply them to the budget.

Section 7.3:Budget register: where are my 
transactions?

Once you create a budget and some transactions, you might be wondering how exactly 

does the budget register work (where your transactions are displayed). This guide aims to 

clarify this!

First, let's say that we have 2 accounts with a couple of transactions inside:
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And that we have created the following budgets, each restarting on the 1st day of each 

month, monitoring relevant expense categories:
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Just as a reminder, the place where your account transactions are listed is called an 

account register and the place where your budget transactions are located is called your 

budget register. Depending on your setup, your account register might be the same as 

your budget register but since we have two separate accounts and three separate 

budgets, the transactions do not appear in just one single budgets but are divided into 

several.

What might strike you as unusual is that you might not see transactions from previous 

month in your budget register. Why is this? The budget register will always display 

transactions from current  budget period only. If you need to review historical budget 

transactions, please go to Reports section and generate one of the budget-related reports.

If you don't see the transactions you were expecting to see, please see this guide.
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Customizing budget register view
In the center of the budget register we can see the transactions that belong to this budget. 

As mentioned above, you will only see transactions from the current budget period. What's

nice about budget register view is that you can customize the bottom part:

Just click on the bar to change what it shows. In MoneyWiz for Desktop, you can see 2 

tabs and customize each one to show one of the following:

• Budgeted–how much money has been assigned to this budget in the current 

budget period. 

• Used–how much of the above money has been already spent. 

• Remaining–how much of Budgeted money is still remaining to spend. 

• Days left–how much longer (in days) until the budget renews. 

• Daily Allowance–how much can you spend daily in order not to exceed your 

budget allowance for this period. 

Explanation of the budget colorful bars and indicators
What's also unique to budget registers is the information you can gather from looking at 

the budgets list:
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This view tells us that:

• Groceries budget has still a lot of remaining budget allowance (a lot of money 

available to spend). We know this because the green bar is very far to the left. We 

also can see that the allowance is 200,00 EUR (amount on the right side) and that 

the current spending is 12,54 EUR (amount on the left side). 

• Entertainment budget–like the Groceries budget–still has some money to spare. 

We'll use it to talk about a different feature of this view. The white line separating 

70,00 and EUR is not a glitch–this white line moves along the blue progress bar to 

demonstrate how much longer until the next budget reset. All those 3 budgets 

repeat on 1st of each month and this guide is written near the end of the month so 

those budget period indicators for each budget are in the same place, near the end. 

This tells us something valuable: 

• if the green bar is ahead of the white line, you need to slow down your 

spending otherwise you risk running out of money before the budget renews, 

• if the green bar is behind the white line, you might consider transferring the 

unused money to a different budget or savings account as it's possible you'll 

have some unspent money in that budget by the end of the month, 

• if the green bar roughly matches the white line, you're on track! 
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• Car expenses budget received much more spending than the other two–which we 

can see by looking at the green bar around the middle and also by comparing 300 

EUR and 172,67 EUR. 

Section 7.4:The budget does not display my 
transactions

Sometimes you might be surprised that some transactions you expected to see in your 

Budget register are not visible. There might be a couple of reasons for it.

Please go through the list below carefully, even if it sounds obvious. We have helped a lot 

of customers with this list and they were all equally surprised as to how basic the problem 

was.

Please double-check the following:

1. Is the transaction you've expected to see within the budget period? Usually budgets

are setup on monthly basis, e.g. from 1st day of the month to the last. The 

transaction you  expected to see could be, for example, with a date of nth day of the

previous month. If your budget started in the past, that transaction might still affect

the budget allowance (if Rollover is enabled), but it won't be visible in the Budget 

register as it only displays transactions from current budget period. You can find 

older transactions using budget reports. 

2. Does the transaction you've expected to see have a proper category assigned? 

Only transactions that have the category you set the budget to monitor will appear 

in the budget register. 

3. Is the transaction you've expected to see created inside the account you've set the 

budget to monitor? 

4. Did you set the budget to require one or more transaction tags? If yes, your 

transactions needs to have at least one of those tags. 
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If the above does not help, try the following:

1. Try changing the budget filters a little to see if your transaction appears. 

2. Try creating the transaction right from the Budget register. It's no different than 

creating the transaction in the usual way (from the Account register) apart from the 

fact that you're offered only the accounts and categories that the budget monitors. 

Remember to add a tag if your budget requires one! Now check if this transaction 

appears in the budget. If yes–please go back to your Account register and compare 

the two transactions. 

If none of the above help, please let us know as the reason might lie somewhere else. But 

those steps have helped a lot of customers so there are high chances it'll help you as well.

Section 7.5:How to edit a budget?

Editing a budget allows you to modify all of the budget properties you've set when creating

it. What's important to remember is that when modifying a budget, the changes you make 

are applied to all budget periods–past, current and future. There is currently no way of 

editing a budget to prevent historical budgets from being affected.

To begin modifying a budget, switch to the Budget section of the application from the 

sidebar and then do one of the following:

• double-click on the budget name in the sidebar, 

• right-click (or left-click while holding Control key if you have right-click disabled) on 

the budget name in the sidebar and select Edit. 
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In the window that opens, you'll be see all the account properties that you saw when 

creating the budget in the first place.

Remember! Changing anything–for example the budget balance–would cause it to be 

modified to all budget periods–not only the current and the future ones but to the past ones

too.

Section 7.6:How to delete a budget?

Deleting a budget is very easy. What's important to remember is that deleting a budget 

does not delete transactions visible inside. It's also very easy to re-create a budget.
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To delete a budget, please first switch to the Budgets section of MoneyWiz and then right-

click on the budget you wish to delete (or left-click while holding Control key on your 

keyboard if you have right-click disabled) and choose Delete.

Deleting a budget does not mean deleting transactions stored inside. If you wish to do 

that, please delete the transactions separately or consider deleting the entire account.

Section 7.7:How to transfer money between budgets 
or envelopes?

Transferring money between budgets or envelopes allows you to re-allocate funds from an

over-performing budget to an under-performing one, covering the deficit. This is useful, for 

example, if it's end of the month and your Entertainment budget still has some money left. 

Instead of looking for a way to quickly spend that money, you could re-allocate it to your 

Emergency Fund for example.

To create a budget transfer, click on the + button in the bottom-right corner of the budget 

screen (while viewing a budget you want to make the transfer from). A window will open:
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• From and To Budget: if needed, you can change where the transfer will draw 

from and where it'll arrive. 

• Transfer amount: how much money to transfer from one budget to another. 

• Description: the text to go with the transfer. 

• Date and time: the date and time of the transaction. 

Once you save the changes, the source budget will see its budget allowance drained by 

the specified amount and the target budget will be replenished by the same amount.

Section 7.8:How to exclude transactions from a 
budget?

By default, budgets will display any transaction that:
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• falls within the budget period, 

• originates from an account that budget monitors, 

• is assigned a category that the budget monitors. 

Sometimes, however, you might need more fine-tuned control over which transactions 

arrive in a budget. That's where transaction tags can come in handy. You can create a 

budget that requires some transaction tags to be present–transactions without those tags 

would not be displayed in the budget. This allows you to have Personal and Business 

transactions (tagged accordingly) and separate budgets, while using the same accounts 

and/or categories.

Please check the How to create a budget? and How to edit a budget? for more information

on the transaction tags property in budgets and how they work.
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Section 8.1:Generating reports

MoneyWiz features many ready-to-use templates that you can use to quickly gain more 

detailed insight into your finances. This guide describes how to generate a report.

To begin, switch to Reports section of the application. Once there, you'll notice that there 

are a couple of report-categories:

• Accounts 

• Net Worth–evolution of balance of all your accounts combined (unless some 

were manually excluded from Net Worth) over time. 

• Balance Over Time–evolution of balance of selected accounts over time. 
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• Cashflow–report separating money going in and out for selected accounts 

combined for a specified period. 

• Budgets 

• Compare Budgets–puts two or more budgets in a pie chart to compare the 

budget allowances of each for a single point in time. 

• Balance Over Time–the balance of a single budget over time (budgeted 

balance, spent and remaining). 

• Categories 

• Compare Expense/Income Categories–puts two or more categories of the 

same type (expense/income) in a pie chart to compare them for a single point

in time. 

• Expense/Income Category Over Time–the balance of one or more categories

of the same type (expense/income) over time for a selected period. 

• Breakdown Expenses/Incomes Over Time–a spreadsheet report for a 

selected period, where your categories are listed in rows and the period is 

listed in columns. 

• Payees

• Compare Expense/Income Payees–puts two or more payees of the same 

type (expense/income) in a pie chart to compare them for a single point in 

time. 

• Expense/Income Payee Over Time–the balance of one or more payee of the 

same type (expense/income) over time for a selected period. 

• Breakdown Expenses/Incomes Over Time–a spreadsheet report for a 

selected period, where your payees are listed in rows and the period is listed 

in columns. 

• Tags 
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• Compare Expense/Income Tags–puts two or more tags of the same type 

(expense/income) in a pie chart to compare them for a single point in time. 

• Expense/Income Tag Over Time–the balance of one or more tag of the same

type (expense/income) over time for a selected period. 

• Breakdown Expenses/Incomes Over Time–a spreadsheet report for a 

selected period, where your tags are listed in rows and the period is listed in 

columns. 

• Spreadsheets 

• Breakdown Payees over Categories–a spreadsheet report for a selected 

period, where your payees are listed in rows and categories as columns. 

• Breakdown Categories over Tags–a spreadsheet report for a selected period,

where your categories are listed in rows and tags as columns. 

• Breakdown Payees over Tags–a spreadsheet report for a selected period, 

where your payees are listed in rows and tags as columns. 

• Other 

• Statistics–an unique text-only report where we display various statistical 

information for selected accounts and period, such as total average expense 

amount, top expense categories, top income payees, number of 

transactions ,etc. 

• Profit & Loss–powerful report, allowing you to display expense and income 

categories in a single report, summing up a period of time. 

• Spreadsheet–allowing you to generate a custom spreadsheet report (you get 

to choose what's displayed in rows and what's displayed in columns). 

• Custom report–allowing you to generate a custom pie/chart/line report. 

To generate a report, just click on one of the icons described above. You'll be asked for 

some additional information, such as the accounts or categories to be included. 
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Generating one of the custom report is really no different than using one of the templates–

you simply choose what to include in the report and how to represent it on the screen.

Section 8.2:How to save a report for later use?

There might be some reports that you like to generate regularly. Choosing the same report

configuration over and over might become inconvenient quickly, which is why MoneyWiz 

allows you to save reports so that you can re-generate them later with a single click.

Once you've generated a report you want to save for later, look for the Save report button 

in the bottom-right corner and then click Save locally. You will be asked to give a name for 

that report.

 Once a report is saved locally, it'll sync to other devices as well via SYNCbits, allowing 

you to re-generate it from any other device. Saved reports are listed at the bottom of the 
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Reports section. Please note that it is not currently possible to edit saved reports or re-

arrange them. To do that, you'd need to save the report again and delete the old one.

An important note about the report periods. When generating a report, you're being offered

a couple of periods such as Last Month. If you save a report with such period, each time 

you generate it, it'll be generated for literally last month–if you first created the report in 

February, it'd show January. But if you'd later re-generate it in May, it'd show you April. If 

you don't want this to happen and prefer that this report constantly shows the same period 

over and over, use the Custom period and set specific date range.
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Section 8.3:How to export a report to PDF or CSV?

Sometimes you need to manipulate the report generated in MoneyWiz further than what 

MoneyWiz allows–that's where the versatile CSV export comes in. You'll be able to 

manipulate it in Excel or Numbers or OpenOffice/LibreOffice package. There are also 

times when you need to show a report to someone or print it out–that's when PDF export 

comes in!

To export a report into one of those formats, click on Save report in the bottom-right of a 

generated report. From the list of options select Export and then choose a format–CSV or 

PDF. CSV allows some modifications regarding the date format and encoding–when in 

doubt, just leave it as it is.
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Remember–the exported report will look like the report in MoneyWiz. If you have some 

rows collapsed (i.e. transactions are collapsed and not visible), you won't see them in the 

exported report. To see all transactions, make sure to click on Expand all button.

Please note: it's not currently possible to export Spreadsheet-type reports to PDF.
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Section 8.4:How to review expenses or incomes in a 
single category over time? 

You might be wondering how much you're spending on groceries over the course of few 

months for example. Maybe you've switched to a new store recently and want to check if 

your spending has changed? You can easily check it with MoneyWiz!

To generate the report, go to Reports section, scroll down to Categories section and find 

Expense Category Over Time report. Select the category you wish to generate it for and 

the period. You'll also be asked how to break the report down–if you're looking at a year of 

data, monthly breakdown probably makes sense. If you're looking at a period of one 

month, you might prefer to select weekly breakdown and so on.

Once generated, you'll be able to view the chart on top to see how has your spending in 

those categories changed over time.
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Section 8.5:How to compare expenses or incomes in 
two payees? 

You might be interested how do your expenses or incomes with two or more certain 

payees compare. For example, which client has paid you more overall in invoices.

To learn this, go to Reports section and search for Compare Income Payees report in the 

Payees section. Select two or more payees to compare and the time period. MoneyWiz 

will sum all incomes with that particular payee and display the results as a pie chart for you

to compare.
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Section 8.6:How to perform a detailed yearly financial
analysis? 

If you need to perform some year-end analysis of your finances–perhaps to share with 

your accountant–don't worry. MoneyWiz can help!

To begin, switch to Reports section and navigate to the bottom, to the "Other" section. 

From there, pick the Profit & Loss report. Fill out the necessary information–do you wish to 

generate the report for specific categories only (perhaps business-related) or all? If you 

wish to exclude some accounts from the report, you can use the "Add filter" button.

Once generated, you'll see a sum of all expense categories and a sum of all income 

categories as well as a grand total below. You can then export this report to show it to your

accountant if needed.
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Section 8.7:How to review the forecast for my savings
account? 

If you have set up your Scheduled transactions to reflect your regular cash flow 

transactions (salaries, bills, transfers to saving account), you can use reports to see how 

your balance would look like in the future. Let's see it with a savings account example!

This guide assumes that you have already set up a scheduled transaction to reflect a 

transfer from your checking account to your savings account.

To begin, go to Reports section and generate Account Balance Over Time report from the 

Accounts group. In the window that opens, select Forecast tab to be able to look into the 

future. Make sure to select your saving(s) account only–we'll cover why in a moment.

Once the report is generated, you'll see a visual representation on top, showing you how 

much your savings account will grow. Using your mouse, you can check what the exact 

balance will be on any given day.
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If you have generated the report for multiple savings accounts, use the + button in the 

bottom-left of the chart to combine all accounts into one line and see combined balance. 

That's why it was important to select savings account only–it would potentially make the 

results less meaningful if you were to select checking accounts as well.

Section 8.8:How to check how much I have spent on a
holiday? 

Using tags you can easily check how much you've spent on a holiday in total. The same is 

also possible without the use of tags but we recommend using them as it is not difficult and

will increase your overall MoneyWiz expertise.
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As you make expenses for your trip (even for those in advance), make sure to enable tags 

and use them. Pick one tag for the trip–for example "Honeymoon in Paris"–and use it 

consistently for all transactions.

Once you've tagged all transactions, just head over to Reports section, scroll down to 

Categories group and generate "Compare Expense Categories" report. You can select all 

categories. The trick is to use the Add filter button and add a tags filter–select your 

"Honeymoon in Paris" tag and generate the report.

Now you can see how much you've spent during the trip overall and also how do your 

expense categories compare. For example, maybe you'll be surprised to see that "Eating 

out" category accounted to around 40% of all your expenses! But that's a honeymoon after

all...
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Chapter 9: Configuration  

Section 9.1:How to enable Dark Mode?

Enabling Dark mode in MoneyWiz will change MoneyWiz color scheme to darker colors, 

making it easier to work with – especially at night. You can enable it from MoneyWiz 

Settings > General > Theme. There are three options to choose from:

• Automatic – MoneyWiz will adapt to the device-wide setting (set in System 

Preferences > General),

• Light – force light mode.

• Dark – force dark mode.

Please note that using Dark scheme requires an active license (Standard or Premium) and

is only available in MoneyWiz for Mac at this time. This feature requires macOS 10.14 

(Mojave) or newer.

Section 9.2:How to import a CSV, QIF, OFX, QFX or 
MT940 file from bank or other application? 

Whether you're switching from another application to MoneyWiz or importing your 

historical data from banks, you might end up with a file in one of those formats: CSV 

(comma-separated values), QIF (Quicken Interchange Format), OFX (Open Financial 

Exchange), QFX, (Quicken Financial Exchange) or MT940 (SWIFT). MoneyWiz can 

handle importing those so read on to learn how!

Please note that Windows version cannot currently import MT940 files. In order to import 

those types of files on Mac, you might need to change the file extension to .txt
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application? 

In order to begin importing a file, you need to "feed" it into the application. There are 

several ways of doing this:

• Mac: 

• click on go to File menu bar item at the top -> Import and point to the file, 

• drag and drop the file into MoneyWiz window or the icon. 

• Windows: 

• click on the icon representing a square with an arrow pointing inwards from 

the sidebar, 

• drag and drop the file into MoneyWiz window or the icon. 

Once the file is loaded, you'll be presented with an Import Wizard that will guide you 

through the import process.

Match CSV fields
When importing a CSV file, MoneyWiz will also ask you to determine how the fields in the 

CSV file would relate to the transaction properties in MoneyWiz. You should be careful 

with that part as many banks would export all kinds of information like codes you don’t use,

or numbers that have no meaning for you. In any case you should not link those, but make

sure you have mapped at least the Date, the Amount and the Payee or Description.

If you are having trouble with this part, you might want to check if you can reformat your 

CSV file according to our guidelines.

Select Date format
MoneyWiz recognizes many date formats but sometimes it might need some help. For 

example, with dates like 6/6/2019, is this mm/dd/yyyy or dd/mm/yyyy? If MoneyWiz cannot

figure out the date format without your help, it'll show you a couple of transactions and ask 

you to select the correct date format used throughout the file.
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Link Accounts
MoneyWiz will list all the accounts it has found transactions for inside the file and ask you 

to link those accounts with accounts in your MoneyWiz database. Please note that you 

need to create those accounts before importing.

During this stage simply link the accounts on the left with respective accounts on the right.

Link Payees
In most cases bank statements contain the name of the payee and other information which

describes the person or company which you were paid by or you paid to. You can link the 

payees found in the bank statement file to your MoneyWiz payees or you can create new 

payees.

Once you link these payees, the next time you import a file which contains information for 

some or all of them, by default MoneyWiz will have them pre-selected the same way you 

configured the last time. It will ask you how to link only for newly found payees.

If there are no payees found in the bank statement file, this phase will not appear.

Link Categories
It is rarely the case for banking institutions to include categorization in the exported bank 

statement file, but if you exported your data using a financial software it is very likely that 

categorization will be included. In that case you will be asked to link the categories found 

in the file you are importing to already existing categories in MoneyWiz. You will be given 

the option to create new categories as well.

Note that if you select the Create New Category option, the category will be created with a 

question ? mark icon. It may be worth going through all new categories to change their 

icons to something more meaningful. See Managing Categories guide.
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Once you link these categories, the next time you import a file which contains information 

for some or all of them, by default MoneyWiz will have them pre-selected the same way 

you configured the last time. It will ask you how to link only for newly found categories.

If there is no categorization in the bank statement file, on this phase you will be asked to 

link the payees to your existing categories. This will help you have your transactions 

properly categorized right after you import them.

You can select a proper category for all payees found in the file you are importing or you 

can leave them Not Linked. If you select the latter, the imported transactions will not be 

categorized.

These links are also saved so the next time you import a bank statement, the app will 

automatically suggest you to use the same categorization.

Transaction duplicates detection
MoneyWiz checks all transactions you wish to import against already existing transactions 

and in case it finds possible duplicates it will ask you what to do. This can happen for a 

number of reasons, for example:

• you are trying to import the same bank statement file for the second time or, 

• you have imported all transactions for September and you are trying to import a 

bank statement which includes transaction from 25 Sep to 25 Oct for example. In 

this case transactions that appear between 25 and 30 Sep can be duplicated or you

can skip them or, 

• you are importing the two accounts which participate in the same transfer 

transaction. 

These phases will not appear if MoneyWiz can recognize the format of the dates and there

are no duplicate transactions. After you set everything MoneyWiz will start importing all 

transactions that are listed in the file you selected for import.
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Section 9.3:How to enable, disable and manage 
currencies? 

MoneyWiz has support for all world currencies and a hundreds of crypto-currencies like 

Bitcoin. By default only a few currencies are enabled so that you do not go through a pile 

of them when registering a transaction. However, you can enable additional ones at any 

time. This guide contains guidance on how to enable additional currencies for you to use.

To begin, go to MoneyWiz Settings:

• On Mac: 

• go to MoneyWiz menu bar in the top-left and click on Settings, 

• click on the gear icon in the bottom-left of the window, 

• use this keyboard combination: ⌘ cmd + , (comma). 

• On Windows: 

• click on the gear icon in the bottom-left of the window, 

• use this keyboard combination: control + , (comma). 

Once you've opened the Settings window, navigate to Currencies tab.

The first thing you might notice is the setting for "Show currency sign, instead of currency 

code". What it does is that in places where currency is displayed, you might decide 

between $ and USD.

Further down you can switch between Fiat currencies (national currencies) and Crypto 

currencies (only traded online). The search bar allows you to search for a particular 

currency. Put a tick in a check box to enable a currency or remove it to disable it.

If you wish to change your local currency (the currency that your Net Worth is displayed in 

and multi-currency reports are generated in), just click on a currency to select it and then 

click Select Local Currency near the bottom of the window.
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Section 9.4:What is SYNCbits? Do I have to use it? 

SYNCbits allows you to sync your MoneyWiz and MileWiz-related data across other 

devices. It is a  service that we (creators of MoneyWiz) have created. In early MoneyWiz 

days, the service was called SyncEverything! but in version 1.5 we have done a huge 

overhaul of the service, rebranding it to SYNCbits. The service even has its own website!

Do you read my data?
As you can see in our Privacy Policy, we are not in the business of harvesting, processing 

and selling your finance information. If you pay the subscription fee or make the one-time 

purchase, we make money. But we don't make any extra coin by selling your data to 

advertisers. Your data is yours–that's a commitment we've had even since our sync 

service was called SyncEverything!. Name might have changed but our commitment to 

data privacy and security did not.

Your data is secured in heavily encrypted form on our servers. If we don't have your 

account password, we cannot access the information. This means that if you forget your 

SYNCbits password and security answers, we can only hope to help you retrieve the data 

from a local database file on one of your devices. If no such copy exists, there is no way to

decrypt your account. We just technically can't access your data.

Why not use Dropbox, iCloud, Microsoft OneDrive or Google 
Drive instead?
We do use Dropbox but only for syncing your transaction attachments. As for the general 

sync, we did not want to tie ourselves with an external company. SYNCbits holds your 

sensitive financial information. You're willing to trust us with it so we want to build on this 

trust and keep your data secured at all times. If we were to use an external service for 

general sync, we'd be asking to not only put your trust in us but also in an external 

company.
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Working on our custom syncing service also makes sense from a business standpoint. 

SYNCbits is crucial for MoneyWiz operations so we do not wish to outsource such an 

important part of our business to someone else.

What's also important is that some syncing platforms–like Apple's iCloud–are restricted to 

some platforms, while we want MoneyWiz to be as universally accessible as possible. 

Designing our own syncing service allows us to spread to new platforms easier.

Those three reasons were behind our decision to develop and maintain our custom-built 

syncing service. We are committed to keep it private and secure.

Do I have to use SYNCbits?
Having a SYNCbits account is only mandatory if you plan to use Online Banking feature.

Other than that, it is optional so if you prefer, you can keep your data on just one device. 

Please note that in such case, you should make regular backups of your database as your 

device is the only location of your MoneyWiz database.

Section 9.5:How to create new SYNCbits account?

Please note that you should always create your SYNCbits account from a device where 

you already have some data present. MoneyWiz will create your account and 

automatically upload your existing data to this account.

To create a SYNCbits account:

• On Mac: 

• click on the round avatar icon in the top-left corner. If you are not currently 

signed in, a sign up form will appear, 

• find the menu bar at the top of the screen, locate SYNCbits and select Sign 

Up. 
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• On Windows: 

• click on the round avatar icon in the top-left corner. If you are not currently 

signed in, a sign up form will appear, 

• go to MoneyWiz Settings and then switch to SYNCbits section to select Sign 

Up. 

You'll be asked to accept our Privacy Policy. Then a form will appear, asking your to enter 

some information:

• E-mail: this will be your SYNCbits login. This should be a real e-mail as this is also

the e-mail we'll be sending important information regarding your account if 

necessary. 

• Password: any password you wish. Make sure to remember this password! 

• Security question 1: pick from the list of questions and provide an answer. 

• Security question 2: select second security question and provide a password. 

You'll be asked to provide both security answers in case you forget your password. 

Please note that answers are case-sensitive! 

• Join our newsletter: put a check if you wish to subscribe to our low-volume e-

mail newsletter. You can change your subscription settings at any time. 

Tip: if you create a Gravatar account and associate your SYNCbits e-mail with some 

avatar, we'll display that avatar in MoneyWiz!

Section 9.6:How to sign in to a SYNCbits account? 

Once you've created your SYNCbits account from one device, you should now sign into it 

using all other devices:

• On Mac: 

Page 147 out of 172

https://gravatar.com/
https://wiz.money/support/privacy-policy/


Section 9.6:How to sign in to a SYNCbits account? 

• click on the round avatar icon in the top-left. If you have an empty database, 

you'll be presented with signing in form, 

• click on SYNCbits in the top menu bar. 

• On Windows: 

• click on the round avatar icon in the top-left. If you have an empty database, 

you'll be presented with signing in form, 

• go to MoneyWiz Settings, then SYNCbits and then Sign In. 

MoneyWiz will begin to download your data from SYNCbits. You should keep MoneyWiz 

running during this process–it will go from stages 1/5 to 5/5, with 3/5 stage being most 

time-consuming on large databases. If your database contains a lot of data, it might go 

faster if you plug your device to a charger so the device can assign more computing power

to MoneyWiz process.

Section 9.7:How to sync transaction attachments 
(images and PDFs)? 

MoneyWiz uses SYNCbits to sync your accounts, transactions and other MoneyWiz data 

among other devices. By default, it does not sync your transaction attachments (images 

and PDF files). If you wish to sync them as well, you'll need to connect MoneyWiz to 

Dropbox.

To sync your attachments, please do the following on all devices you wish to keep in sync:

• Mac: find SYNCbits menu bar item at the top of the screen and make sure you're 

signed in. Then select Receipt sync and click on Dropbox to link your account. 

• Windows: go to MoneyWiz Settings -> SYNCbits and make sure you're signed in. 

Then click on Receipt sync and link MoneyWiz to Dropbox. 

Your images will be placed in the following location: Dropbox root folder/MoneyWiz.
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You can now start adding attachments to your transactions (if you haven't done so 

already–MoneyWiz will sync previous attachments too). To begin, make sure that you've 

adjusted your Transaction layout settings to allow attaching images and just either edit 

exiting transactions or create new ones with attached images.

If your transaction attachments are not syncing:

1. Double-check that all devices are linked to your Dropbox account (see above). 

2. Check if you did not run out of free space on your Dropbox account or reached the 

device limit (Dropbox Free tier imposes a 3 device limit). 

3. Check if your Dropbox images folder contains the images you are looking for. 

4. Open MoneyWiz on all devices and let them run for 2-5 minutes and check for any 

changes. If you did notice improvement, it means MoneyWiz is still 

uploading/downloading your images so please keep MoneyWiz open for bit longer. 

A couple of notes:

• it can take some time to upload all your attachments at first so please be patient, 

• there is currently no progress indicator as to how many attachments did MoneyWiz 

download or upload so please keep MoneyWiz open as long as you can see it 

actively uses Internet connection, 

• there is currently no way to change the location of the folder that MoneyWiz creates 

in your Dropbox, 

• when attaching PDFs only the first page of the document is attached as JPEG, 

• you can only add images using MoneyWiz application–placing the photos inside 

"MoneyWiz" folder in Dropbox using macOS's Finder or Windows' Explorer or 

Dropbox website will not attach them to any transactions in MoneyWiz. 
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Section 9.8:How to modify transaction layout 
settings?

MoneyWiz allows you to modify the window that appears when you begin adding new 

transaction. For example, you can hide the Currency switcher if all your accounts are in 

the same currency. This also allows you to enable check field, tags, attach image button 

and more. You can also re-order the fields to better match the order you're entering the 

data in.

In order to access Transaction layout settings, go to MoneyWiz Settings and find 

Transaction layout tab:

• Mac: 

• click on the gear icon in the bottom-left, 

• click on MoneyWiz menu bar item in the top-left -> Settings, 

• use this keyboard combination: ⌘ cmd + , (comma). 

• Windows: 

• click on the gear icon in the bottom-left, 

• use this keyboard combination: control + , (comma). 
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Re-ordering fields
In order to re-order transaction entry fields, you need to use the "Custom" template on 

Mobile. Simply tap and hold on the three-lines handle to the right then drag it to desired 

position.

On Desktop, just click anywhere on the transaction entry list and drag the field to a desired

position. 

Please note that the text-based field you place on top of other text-based fields (not 

necessarily on top) will control what information is displayed on transaction listings. More 

information can be found here.
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What do Basic and Extended headings mean?
On the Transaction layout fields list, you'll notice that there are two headings: Basic and 

Extended. Any field dragged into Basic group will appear during transaction entry as you'd 

expect. On the other hand, any field dragged into the Extended group will be hidden until 

you reveal it using a button. It's very useful for fields that you don't use in every 

transactions (e.g. Memo field or Check number).

Description of each setting
Let's now review each setting individually and how you can change it.

Account

Controls whether the account picker is visible. If you have just one account, you can 

disable it but keep it in case you have more than one account.
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Amount

While you cannot hide the amount field (it's quite important one!), you can control it's 

behavior. For example:

• Enter decimal sign automatically: if enabled, if you type 1234, MoneyWiz 

will enter 12.34 so you don't have to worry about decimals. Disable it if you don't like

this behavior (you'll need to enter the decimal separator yourself). 

• Currency: allows you to disable the currency picker. If all your accounts are in the 

same currency, it's safe to disable this. 

• Use calculator keyboard: (present in MoneyWiz for Mobile only) disabled will 

give you a standard num pad for entering amounts. Entering this will switch it to a 

calculator-type num pad which you can use not only to enter amounts but also to 

calculate them (e.g. if you bought 5 packs of cookies for the party, €1.47 each. 

Description

Description is a single-line text that describes what the transaction is about. You can 

disable it here. If you enable it though, you can control it using those settings:

• Auto-fill payee and category: if you enable this, picking a Description from 

the list of suggestions MoneyWiz gives you during transaction entry will cause it to 

automatically fill payee and category fields with the ones that were used last time 

you used this description. 

Payee

Payee is the person or institution participating in your transaction. Using this setting you 

can disable it or configure it:

• Auto-fill description and category: if you enable this, picking a Payee from 

the list of suggestions MoneyWiz gives you during transaction entry will cause it to 

automatically fill description and category fields with the ones that were used last 

time you used this payee. 
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Category

During transaction entry, you can categorize your transactions by giving it a relevant 

category, like Groceries or Gas/Petrol. This setting allows you to disable the category field 

completely or heavily modify it to your preferences:

• Auto-fill description: if enabled, MoneyWiz will automatically fill your 

Description field with the category name in case you leave the Description field 

empty (will do nothing if your Description field is not empty). Disabling this disables 

this feature. 

• Show category icon: when enabled, MoneyWiz will show the category icon 

(that you can modify in Settings -> Categories, more on this here) alongside each 

category in all places: category lists, transaction lists, etc. If you do not like the 

category icons, you can hide them using this setting. 

• Category icon color style: category icons in MoneyWiz can either have just 2 

colors (red and green), depending on the transaction type (expense/income), 

helping you to identify certain types of transactions faster, or MoneyWiz can use a 

wide variety of colors to describe your category icons. If you set this to Colorful, 

MoneyWiz will randomly colorize your category icons. You can make changes in 

Settings -> Categories (see more here). 

Date & time

Controls whether during transaction entry you'll see the date and/or time.

Check # (Check number)

Check number cannot be enabled here. Instead, you need to enable Check book register 

in an account. You can use Transaction layout to reposition this field though.
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Memo

Memo is similar to Description–it's for storing text-based information about a transaction. 

However, Description can only fit a single line of text. Memo can fit up to 8 lines. Here you 

can control how many lines can Memo field fit.

Attach images

Transactions in MoneyWiz can have images attached (e.g. photos of receipts or the items 

you've bought). You can read more about this here. This setting controls whether to 

display "Add image" button. 

Tags

Whether to display tags field during transaction entry and if yes–what should be the tag 

separator. It can be either semicolon or comma:

tag1;tag2

tag1,tag2

You can read more about working with tags in the Tags guide.

Section 9.9:How to protect MoneyWiz database with a
PIN password code? 

MoneyWiz allows you to set up a 4-digit PIN password code that prevents other people 

from launching MoneyWiz while using your device. You can also use Touch and Face ID 

to speed up the process.

A PIN is a 4-digit code that you enter every time you start MoneyWiz or depending on your

settings after a certain time has passed. The options you have to choose from are:

• Immediately 

• After 1 minute 

• After 5 minutes 
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• After 10 minutes 

• After 15 minutes 

• After 30 minutes 

• After 60 minutes 

By default the app is set to request PIN immediately, which is the most protective option.

Enabling PIN protection
If you are using MoneyWiz on multiple devices, you need to enable your PIN code on just 

one – the new protection setting will sync to other devices automatically. Read below on 

how to enable the PIN code from a particular device and then read on to see more specific

information regarding each platform and PIN protection.

• On Mac find PIN Protection menu bar at the top of the screen -> Enable PIN 

protection and enter 4-digit code. 

• On Windows go to MoneyWiz Settings -> General -> Enable PIN protection and 

enter 4-digit code. 

You can also set MoneyWiz to erase your local data if the PIN has been entered 

incorrectly a couple of times. Please note that if incorrect PIN is entered a specified 

number of times and the data is erased, only the local data is deleted and your 

SYNCbits data (if you have an account) is still available for you to use.

macOS and Windows
Please, note that the timeout option that you set from a Desktop device does not sync 

across your devices – it’s kept only as a local setting. This way you can have your mobile 

devices set to request PIN immediately and your Mac set to request it after 15 minutes of 

inactivity as your desktop computers might be less likely to be accidentally accessed by 

someone.
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As soon as the MoneyWiz window loses focus it starts counting down the time and it will 

request PIN if you return to the app after the timeout has passed.

If you quit the app, the next time you start it, it will request PIN immediately, regardless of 

what the timeout is.

The timeout is only relevant when you keep the app running (also minimized or on another

desktop).

Changing the PIN
You can always change your PIN and this will affect all of your other devices. If your 

device is lost or stolen, change the PIN from any other device. This way your data will stay

protected as the app will start requesting the new PIN.

Section 9.10: Desktop keyboard shortcuts 

Keyboard shortcuts allow you to quickly perform some common operations, speeding up 

your use of MoneyWiz. They might appear complicated and difficult to remember at first 

but with enough practice you'll start intuitively recalling them!
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Mac
• ⇧ Shift + ⌘ cmd (command) and click arrows up/down to go through MoneyWiz 

sections such as Accounts, Dashboard, Budgets, Reports, etc. 

• ⌘ cmd + ⇧ Shift + D show/hide Net Worth balance 

• ⌘ cmd + ⇧ Shift + B add Budget 

• ⌘ cmd + ⇧ Shift + G add Group 

• ⌘ cmd + ⇧ Shift + A add Account 

• ⌘ cmd + E add expense 

• ⌘ cmd + I add income 

• ⌘ cmd+ T add transfer 

• ⌘ cmd + ⇧ Shift + Z add exchange transaction (Forex accounts only) 

• Tab switch between transaction’s fields such as account, category, amount, payee, 

description etc. 

• Space bar to open the list of Categories 

• Enter to select a Category 

• Esc to go back 

If the Tab key skips some fields on Mac, you need to enable “Use keyboard navigation to 

move focus between controls” in your Mac System Preferences > Keyboard > Shortcuts.

Windows
• Shift + Control and click arrows up/down to go through MoneyWiz sections such as 

Accounts, Dashboard, Budgets, Reports, etc. 

• Control + Shift + D show/hide Net Worth balance 

• Control + Shift + B add Budget 

• Control + Shift + G add Group 

• Control + Shift + A add Account 

• Control + E add expense 
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• Control + I add income 

• Control + T add transfer 

• Control + Shift + Z add exchange transaction (Forex accounts only) 

• Tab switch between transaction’s fields such as account, category, amount, payee, 

description etc. 

• Space bar or Enter to open the list of Categories 

• Space bar or Enter to select a Category 

• Esc to go back 

Section 9.11: How to manually access or back up 
the desktop database? 

If you wish to completely remove MoneyWiz from your device or sync your data cleanly 

from SYNCbits, you will need to remove the local database file. This guide will also be 

useful if you need to access the database file for other reasons, such as sending it to us 

for debugging or making a manual backup of it.

If you can still launch MoneyWiz
Remember – if you want to prevent MoneyWiz from syncing some changes via SYNCbits 

you might not want to launch MoneyWiz during the restore process.

If launching MoneyWiz is not a problem (remember that it’ll also sync latest changes from 

SYNCbits as soon as you launch unless you completely disconnect from Internet), simply 

launch the application, go to MoneyWiz Settings > Backup > Locate data folder. This will 

open a new window with your database files visible. Before you proceed, it’s best to 

completely close MoneyWiz.

• If you’re on a Mac, your database file consists of 3 files: ipadMoneyWiz.sqlite, 

ipadMoneyWiz.sqlite-shm and ipadMoneyWiz.sqlite-wal
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• If you’re on Windows, your database is just one file: moneywiz-release.db

• On both platforms, your images are stored in “Images” folder.

Select the file(s) you wish to copy and perform the operation you wanted to perform.

If you can’t launch MoneyWiz for Mac anymore
Your MoneyWiz data lives in the following folder:

~/Library/Containers/XXX

The “~/Library/Containers” part is common for majority of the applications on your Mac. 

The “XXX” is different depending on which version of MoneyWiz you’re using. Please see 

below for detailed instructions tailored to your MoneyWiz version. Not sure which version 

you have? Just try locating the folder from each of the sections and if you installed just one

version of MoneyWiz, you’ll only find one of the folders.

If you can find multiple folders, you’ve had multiple versions of MoneyWiz installed – 

please contact us so we can help clear this out.

Please note that the Library folder in your User folder is hidden. You 

cannot simply click on it in Finder or search for it. You need to use a special function to get

there.

With MoneyWiz quit, please open Finder on your Mac and from the menu bar at the top 

choose Go -> Go to Folder… (alternatively you can press this shortcut: ⇧ + ⌘ + G). Delete 

any contents that are in the text box that appears and paste the path that you need and 

then press Enter – the following screenshot explains how to do this:
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MoneyWiz 3 from our website

• To access database files (remember that MoneyWiz database files consist of 

3 files in SQLite format): 

~/Library/Containers/com.moneywiz.mac.off-mas.free/Data/Library/Containers/
com.moneywiz.mac.off-mas.free/Data/

• To access Images folder: 

~/Library/Containers/com.moneywiz.mac.off-mas.free/Data/Library/Containers/
com.moneywiz.mac.off-mas.free/Data/Images/

• To access automatic backups (those are files with name in format similar to 

MoneyWizBackup_2018-02-09 14/11/51 +0100): 

~/Library/Containers/com.moneywiz.mac.off-mas.free/Data/MoneyWizBackups/

MoneyWiz 3 from Mac App Store

• To access database files (remember that MoneyWiz database files consist of 

3 files in SQLite format): 

~/Library/Containers/com.moneywiz.mac.free/Data/Library/Containers/
com.moneywiz.mac.free/Data/
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• To access Images folder: 

~/Library/Containers/com.moneywiz.mac.free/Data/Library/Containers/
com.moneywiz.mac.free/Data/Images/

• To access automatic backups (those are files with name in format similar to 

MoneyWizBackup_2018-02-09 14/11/51 +0100): 

~/Library/Containers/com.moneywiz.mac.free/Data/MoneyWizBackups/

MoneyWiz 3 from Setapp

• To access database files (remember that MoneyWiz database files consist of 

3 files in SQLite format): 

~/Library/Containers/com.moneywiz.mac-setapp/Data/Library/Containers/
com.moneywiz.mac-setapp/Data/

• To access Images folder: 

~/Library/Containers/com.moneywiz.mac-setapp/Data/Library/Containers/
com.moneywiz.mac-setapp/Data/Images/

• To access automatic backups (those are files with name in format similar to 

MoneyWizBackup_2018-02-09 14/11/51 +0100): 

~/Library/Containers/com.moneywiz.mac-setapp/Data/MoneyWizBackups/
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If you can’t launch MoneyWiz for Windows anymore
Open Windows Explorer folder browser and click on the address bar. In there, type:

%APPDATA%

and press Enter. This should get you to the following path:

C:\Users\YourUserName\AppData\

However, it is possible that you’ve been placed in a variation of that folder, for example 

“Roaming”. If that’s the case, just click on “AppData” in your address bar to get out of 

Roaming folder (which is inside AppData). Then please navigate to Local -> SilverWiz -> 

MoneyWiz. Your final path should be the following:

C:\Users\YourUserName\AppData\Local\SilverWiz\MoneyWiz\

Inside, you’ll find various files and folders. The database file is the moneywiz-

release.db file, while your images will be stored in the Images folder.

Section 9.12: Enabling automatic database backups
on desktop 

Both MoneyWiz for Mac and Windows allow you to enable automatic backups feature 

which will automatically backup your MoneyWiz database at certain points. In this guide, 

we’ll show you how to enable it.

Do you have both MoneyWiz for Mac and MoneyWiz for Windows? It’s not a problem to 

enable automatic backups on both.

Enabling automatic backups on Mac
To begin, please click on MoneyWiz menu bar item in the top left (next to the Apple logo) 

and choose Settings. Alternatively, click on the small Settings button at the bottom of the 

sidebar.
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Once the Settings window appears, please switch to Backups tab:

To enable the automatic backups, simply put a checkbox next to “Enable automatic 

backups”. On top of that, there are two things that you can configure:

• Backup frequency: when should MoneyWiz create the backups. You can choose 

from: 

• Every time I quit MoneyWiz: pretty self-explanatory 

• Once a day – MoneyWiz will create a backup only once a day (but you need 

to launch MoneyWiz for that to happen) 

• Once a week – MoneyWiz will create a backup only once a week (but you 

need to launch MoneyWiz for that to happen) 
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• Once a month – MoneyWiz will create a backup only once a month (but you 

need to launch MoneyWiz for that to happen) 

• Number of backups to keep: you might not want to keep 100 backups as those 

would in time start affecting your disk space. You can choose any value between 1 

and 5. 

Please note that the backup path is not configurable.

Enabling automatic backups on Windows
To begin, please click on the small Settings button at the bottom of the sidebar.

Once the Settings window appears, please switch to Backup tab:
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To enable the automatic backups, simply put a checkbox next to “Enable automatic 

backups”. On top of that, there are two things that you can configure:

• Backup folder: using the Browse button, you can choose where the backups should 

be made. 

• Backup frequency: when should MoneyWiz create the backups. You can choose 

from: 

• Every time I quit MoneyWiz: pretty self-explanatory 

• Once a day – MoneyWiz will create a backup only once a day (but you need 

to launch MoneyWiz for that to happen) 

• Once a week – MoneyWiz will create a backup only once a week (but you 

need to launch MoneyWiz for that to happen) 

• Once a month – MoneyWiz will create a backup only once a month (but you 

need to launch MoneyWiz for that to happen) 

• Number of backups to keep: you might not want to keep 100 backups as those 

would in time start affecting your disk space. You can choose any value between 1 

and 5. 

Section 9.13: Restoring from a database backup on 
Mac

There will be 3 steps we’ll need to take (4 if you’re using SYNCbits to sync your data). Feel

free to contact us at any time. If in your e-mail you’ll mention that you’ve seen this guide 

and tell us which step you got stuck on, this will eliminate the need for us to ask questions,

improving the case resolution time.
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Step 1: Access your MoneyWiz for Mac backups
We have a separate guide that explains how to access various MoneyWiz database files, 

including how to access the backups folder. Please proceed only if you have obtained the 

backup file dated to the date you need.

In that guide, you need to access the folder we describe as “automatic backups” folder.

Step 2: Change the backup file name
Once you obtain the backup file, you might think that it does not look like anything that 

MoneyWiz – or any other application on your computer – can open. But here’s the secret: 

the file is actually a ZIP archive that you can decompress to reveal the files stored within.

Suggestion: duplicate the backup file before you begin. In case anything goes wrong, you 

still have an intact version of the backup.

To begin, please click once on the name of the backup file you’ve chosen and macOS 

Finder should allow you to rename the file. If that does not happen, right-click and choose 

“Rename”. You can rename it to anything you wish – including leaving the name as it is – 

but what you do need to do is to add a “.zip” at the end. So something like this:

MoneyWizBackup_2018-02-09 14/11/51 +0100

needs to become this:

MoneyWizBackup_2018-02-09 14/11/51 +0100.zip

Notice the bold part. That’s a period and “zip”. When you confirm the choice, Finder might 

ask you if you are sure – confirm again.

Now it should be recognized as a regular ZIP file – just click twice on it and it’ll unpack the 

archive for you. It’ll create a new folder with the contents of the file.
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Step 3: Replace the database backup
Please navigate into the folder that the ZIP archive created for you and notice that there 

are various files and folders inside. Leave it be for now and then access MoneyWiz’s 

database folder again. Please note that previously you had to access the backups folder 

for your MoneyWiz version – this time you need to access the database folder. It’s the first 

path that ends with “…/Data/”.

Once you have navigated to your MoneyWiz database folder, you should see similar files 

and folders as the ones you’ve found in your backup. Now, please select all of the files you

see in your database folder and place them to Trash (but perhaps don’t empty the Trash 

just yet). Then drag (or copy and paste) the files and folders found in your backup archive 

folder into the real database folder. That’s it – you have now successfully restored from 

backup. If you do not use our SYNCbits syncing service, you are done. If you do use 

SYNCbits syncing service, there is one more step. If you are not sure, just 

follow the step below as well.

Step 4: Re-creating your SYNCbits account
If you have a SYNCbits account, all of your account changes are securely stored on our 

SYNCbits server. You have restored your local database but if you simply launch the 

application, MoneyWiz will notice that newer changes are present on the server and will 

just overwrite the earlier backup you wanted to restore.

To prevent this from happening, we need to re-create your SYNCbits account with the 

backup data you have. To do so:

1. Disable all forms of internet connectivity on your Mac: WiFi, Ethernet, LTE shared 

from your phone – everything. Your Mac must not be able to connect to the Internet.

2. Launch MoneyWiz for Mac and verify that the data you’ve restored is OK. 

3. Double-check that you are using SYNCbits service – look at the MoneyWiz sidebar 

to the left. Do you see your e-mail there? If yes – proceed to step 4. If not, this 
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means you are not using SYNCbits and you can skip this step. In that case, it’s safe

to re-enable Internet on your Mac. 

4. If you do see your e-mail in the sidebar, please hold  alt key on your keyboard ⎇

and click on SYNCbits menu bar item at the top of the screen. You can release alt 

key now but navigate to Force sync -> Desync. 

5. Click on that option and wait for your e-mail to disappear from the sidebar. The 

SYNCbits menu bar should also stop showing your e-mail and start showing Sign 

Up/Sign In options instead. If this happens, it’s safe to re-enable your Internet 

connectivity. 

6. Please e-mail us (contact information can be found here) pointing to this article, 

explaining that you are trying to restore from Mac backup and that you have 

successfully completed all 4 steps and wish to re-create your SYNCbits account. If 

you do not include that, we’ll need to ask questions to make sure that all steps were

completed as we don’t want to risk your data getting lost. When writing your 

message, please: 

1. make sure you’re writing from the e-mail address that is your SYNCbits 

account, 

2. tell us on which other devices you’re using MoneyWiz on as well. 

7. Wait for us to get back to you. In the meantime, it’s safe to use MoneyWiz on this 

Mac but please do not launch or use MoneyWiz on other devices – we’ll tell you 

what to do about them. 

Section 9.14: Restoring from a backup on Windows 

There will be 3 steps we’ll need to take (4 if you’re using SYNCbits to sync your data). Feel

free to contact us at any time. If in your e-mail you’ll mention that you’ve seen this guide 

and tell us which step you got stuck on, this will eliminate the need for us to ask questions,

improving the case resolution time.
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Step 1: Access your MoneyWiz for Windows backups
Please navigate to your backups folder. If while setting it up, you’ve set a different path, 

please access that now. In this guide, we’ll use the default one.

Open Windows Explorer folder browser and click on the address bar. In there, type:

%APPDATA%

and press Enter. This should get you to the following path:

C:\Users\YourUserName\AppData\

However, it is possible that you’ve been placed in a variation of that folder, for example 

“Roaming”. If that’s the case, just click on “AppData” in your address bar to get out of 

Roaming folder (which is inside AppData). Then please navigate to Local -> SilverWiz -> 

MoneyWiz. Your final path should be the following:

C:\Users\YourUserName\AppData\Local\SilverWiz\MoneyWiz\

The backup file will have a name like this:

2018-02-09 02_57_46-moneywiz-backup.zip

Step 2: Open the backup file
Suggestion: duplicate the backup file before you begin. In case anything goes wrong, you 

still have an intact version of the backup.

Your backup file is a regular ZIP archive. Just click twice on it or right-click and open in 

your favorite ZIP archive application to access the backup. Inside, you’ll find a “moneywiz-

release.db” file – that is your database.

Step 3: Replace the database backup
In order to restore from backup, you simply need to replace the “moneywiz-release.db” file 

from your MoneyWiz database folder (C:\Users\YourUserName\AppData\Local\SilverWiz\

MoneyWiz\moneywiz-release.db) with the one from your backup.
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That’s it – you have now successfully restored from backup. If you do not use our 

SYNCbits syncing service, you are done. If you do use SYNCbits syncing service,

there is one more step. If you are not sure, just follow the step below as well.

Step 4: Re-creating your SYNCbits account
If you have a SYNCbits account, all of your account changes are securely stored on our 

SYNCbits server. You have restored your local database but if you simply launch the 

application, MoneyWiz will notice that newer changes are present on the server and will 

just overwrite the earlier backup you wanted to restore.

To prevent this from happening, we need to re-create your SYNCbits account with the 

backup data you have. To do so:

1. Disable all forms of internet connectivity on your computer: WiFi, Ethernet, LTE 

shared from your phone – everything. Your PC must not be able to connect to the 

Internet. 

2. Launch MoneyWiz for Windows and verify that the data you’ve restored is OK. 

3. Double-check that you are using SYNCbits service – look at the MoneyWiz sidebar 

to the left. Do you see your e-mail there? If yes – proceed to step 4. If not, this 

means you are not using SYNCbits and you can skip this step. In that case, it’s safe

to re-enable Internet on your PC. 

4. If you do see your e-mail in the sidebar, please go to Settings (access it by clicking 

on the little cog icon at the bottom of the sidebar) -> SYNCbits and click 10 times on

your e-mail until a hidden menu appears. Find one called Desync. 

5. Click on that option and wait for your e-mail to disappear from the sidebar. If this 

happens, it’s safe to re-enable your Internet connectivity. 

6. Please e-mail us (contact information can be found here) pointing to this article, 

explaining that you are trying to restore from Windows backup and that you have 

successfully completed all 4 steps and wish to re-create your SYNCbits account. If 
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you do not include that, we’ll need to ask questions to make sure that all steps were

completed as we don’t want to risk your data getting lost. When writing your 

message, please: 

1. make sure you’re writing from the e-mail address that is your SYNCbits 

account, 

2. tell us on which other devices you’re using MoneyWiz on as well. 

7. Wait for us to get back to you. In the meantime, it’s safe to use MoneyWiz on this 

PC but please do not launch or use MoneyWiz on other devices – we’ll tell you what

to do about them.
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